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Kata Sambutan

      
      

 Puji syukur kami panjatkan ke hadirat Allah SWT, berkat rahmat dan 
karunia-Nya, Pemerintah, dalam hal ini, Departemen Pendidikan Nasional, pada 
tahun 2009, telah membeli hak cipta buku teks pelajaran ini dari penulis/penerbit 
untuk disebarluaskan kepada masyarakat melalui situs internet (website) Jaringan 
Pendidikan Nasional.
 Buku teks pelajaran ini telah dinilai oleh Badan Standar Nasional 
Pendidikan dan telah ditetapkan sebagai buku teks pelajaran yang memenuhi 
syarat kelayakan untuk digunakan dalam proses pembelajaran melalui Peraturan 
Menteri Pendidikan Nasional Nomor 49 Tahun 2009 tanggal 12 Agustus 2009.
 Kami menyampaikan penghargaan yang setinggi-tingginya kepada para 
penulis/penerbit yang telah berkenan mengalihkan hak cipta karyanya kepada 
Kementerian Pendidikan Nasional untuk digunakan secara luas oleh para siswa 
dan guru di seluruh Indonesia.
 Buku-buku teks pelajaran yang telah dialihkan hak ciptanya ini, dapat 
diunduh (down load), digandakan, dicetak, dialihmediakan, atau difotokopi oleh 
masyarakat. Namun, untuk penggandaan yang bersifat komersial harga 
penjualannya harus memenuhi ketentuan yang ditetapkan oleh Pemerintah. 
Diharapkan buku teks pelajaran ini akan lebih mudah diakses oleh siswa dan guru 
di seluruh Indonesia maupun sekolah Indonesia yang berada di luar negeri 
sehingga dapat dimanfaatkan sebagai sumber belajar.
 Kami berharap, semua pihak dapat mendukung kebijakan ini. Kepada 
para siswa kami ucapkan selamat belajar dan manfaatkanlah buku ini 
sebaik-baiknya. Kami menyadari bahwa buku ini masih perlu ditingkatkan 
mutunya. Oleh karena itu, saran dan kritik sangat kami harapkan.

     Jakarta,  April 2010
     Kepala Pusat Perbukuan
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Kata Pengantar
Puji syukur kami panjatkan kehadirat Tuhan Yang Maha Esa atas rahmat dan karunia-

Nya sehingga kami dapat menyelesaikan buku Teknologi Informasi dan komunikasi untuk
kelas VIII.

Buku ini kami susun berdasarkan Standar Isi 2006 untuk memenuhi kebutuhan Mata
Pelajaran Teknologi Informasi dan Komunikasi di Sekolah Menengah Pertama ( SMP/MTs).
Materi yang kami sampaikan adalah tentang perangkat lunak pengolah kata (Microsoft Word
2003) dan perangkat lunak pengolah angka (Microsoft Excel 2003).

Setiap pokok bahasannya kami sajikan secara sistematis dengan menggunakan bahasa
yang mudah dipahami siswa dan disertai dengan gambar-gambar yang dapat membantu
pemahaman siswa, serta memudahkan siswa melakukan latihan-latihan yang sudah diberikan
sehingga tujuan pembelajaran Teknologi Informasi dan Komunikasi di sekolah dapat tercapai,
yaitu siswa mempunyai pengetahuan dan memiliki keterampilan untuk mengoperasikan
program aplikasi pengolah kata dan pengolah angka.

Buku ini kami lengkapi pula dengan tugas dan latihan serta uji kompetensi untuk menguji
kemampuan nalar dan pemahaman siswa terhadap materi yang telah dipelajarinya. Dalam
buku ini juga disertakan rubrik jendela info dan jendela tips yang berisi tentang info dan tips
untuk menambah pengetahuan siswa.

Tidak lupa kami ucapkan banyak terima kasih kepada semua pihak yang telah memberikan
bantuan, bimbingan, dan dukungannya. Kami menyadari, buku ini masih jauh dari sempurna.
Oleh karena itu, kritik, saran, dan masukan untuk meningkatkan kualitas buku ini sangat kami
harapkan.

Akhirnya, semoga buku ini dapat bermanfaat bagi pengembangan mata pelajaran
Teknologi Informasi dan komunikasi di Sekolah Menengah Pertama (SMP/ MTs).

        Penulis
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Petunjuk Penggunaan Buku

Judul Bab
Pada bagian ini, kamu dapat mengetahui judul bab setiap
materi yang disajikan, gambar pengantar isi bab, serta
paragraf apersepsi.

Peta Konsep
Pada bagian ini,  kamu dapat mengetahui konsep-konsep yang
akan dipelajari dalam setiap bab sehingga dapat
memudahkanmu memahami materi dengan baik.

Materi Pembelajaran
Pada bagian ini,  kamu dapat mengetahui materi-materi sebagai
bahan pembelajaranmu. Materi pembelajaran disajikan  secara
sistematis dengan bahasa yang mudah dipahami.

Aktivitasku
Pada bagian ini,  kamu dapat melakukan kegiatan,
seperti menjawab soal, latihan praktek, dan
sebagainya. bagian ini dimaksudkan agar kamu dapat
memahami materi lebih baik.

Uji Kompetensi
Pada bagian ini,  kamu dapat mengukur
kemampuanmu mengenai materi yang sudah kamu
pelajari yaitu dengan cara menjawab soal-soal pilihan
ganda dan essay.
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Perangkat Lunak Microsoft Word 1

Bab

1
Perangkat Lunak
Pengolah Kata Microsoft
Word

Microsoft Word merupakan program aplikasi pengolah kata yang paling banyak
digunakan. Kamu tentu dapat menggunakan program Microsoft Word dengan
mudah karena Microsoft Word mempunyai tampilan jendela yang dilengkapi dengan
menu-menu dan tombol-tombol perintah yang mudah digunakan. Nah, dalam bab
ini kamu akan mempelajari tentang Microsoft Word dan berbagai macam aplikasinya.

Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) mengetahui sejarah Microsoft Word;
2) mengaktifkan Microsoft Word;
3) mengetahui menu dan ikon dalam Microsoft Word;
4) mengetahui tombol-tombol keyboard dan fungsinya dalam Microsoft Word;
5) menutup program Microsoft Word.
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Perangkat Lunak Pengolah Kata

Cara Mengaktifkan
Microsoft Word

Pengertian Microsoft Word

Mengenal Tombol-tombol
Keyboard yang Dipakai

Microsoft Word

Mengidentifikasi Tampilan
Layar kerja

Microsoft Word 2003

Menu dan Ikon
Microsoft Word 2003

Menampilkan Menu Help
Microsoft Word

Menutup atau Keluar
dari Program

Microsoft Word

Sejarah Singkat
Microsoft Word 2003

Peta Konsep

• Microsoft Word
• Word processor
• Icon

• Toolbar Standar
• Toolbar formating
• Toolbar Drawing

Kata Kunci
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Gambar 1.1 Layout Microsoft Word

Microsoft Word atau yang sering disingkat MS.Word merupakan sebuah
program pengolah kata (Word Processor) yang paling populer, lengkap dan
paling banyak digunakan saat ini. Perangkat lunak ini bersifat fleksibel dan
mudah diintegrasikan dalam program aplikasi lainnya yang dibuat oleh
Microsoft Corporation.

Program pengolah kata Microsoft Word mengeluarkan versi 1.0 sampai
6.0 versi DOS yang berarti program ini bekerja pada sistem DOS. Microsoft
Corporation mengeluarkan 12 versi Microsoft Word antara lain:
• Microsoft Word versi ‘95.
• Microsoft Word versi ‘97.
• Microsoft Word versi 2000.
• Microsoft Word versi 2002.
• Microsoft Word versi 2003.
• Microsoft Word versi 2007.

B. Sejarah Singkat Microsoft Word

C. Cara Mengaktifkan Microsoft Word
Langkah-langkah untuk mengaktifkan program Microsoft Word, antara

lain:
1. Nyalakan komputer kamu dan tunggu sampai komputer menampilkan

area kerja Microsoft Windows.

A. Pengertian Microsoft Word

Adapun yang akan kamu pelajari dalam bab ini, yaitu Microsoft Word
versi 2003.
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Gambar 1.2 Tampilan Menu Start

Selain cara di atas, kamu juga dapat mengaktifkan program Microsoft
Word dengan cara mencari ikon Microsoft Word di layar Dekstop, kemudian
klik ganda atau double klik pada ikon Microsoft Word.

Gambar 1.3 Tampilan ikon Micrososft Word di layar Desktop

Kamu dapat
membuat
Shortcut MS.
Word pada layar
Desktop,
caranya:
1. klik tombol

Start
2. klik pilih All

Programs
3. Pilih

Microsoft
Office

4. Klik kanan
icon MS.
Word

5. Pilih Send To
> Desktop

Jendela Tips

2. Pilih dan klik menu             yang terdapat pada taskbar.
3. Pilih dan klik menu All Programs, kemudian klik menu Microsoft Of-

fice.
4. Pilih menu Microsoft Word.
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Ikon       Fungsi

Gambar 1.4 Tampilan Layar Dokumen Microsoft Word

Maximize Memperbesar ukuran jendela kerja

Minimize Memperkecil jendela kerja

Close Menutup jendela dokumen

Restore Mengembalikan jendela kerja ke ukuran semula

Gambar 1.5 Tampilan Menu Bar

D. Mengidentifikasi Tampilan Layar Kerja Microsoft Word

E. Uraian Singkat Fungsi Daftar Menu dan Ikon dalam Microsoft
Word

Pada Microsoft Word 2003 terdapat tiga jenis toolbar yang sering
digunakan, yaitu: Toolbar Standard, Formatting, dan Drawing. Untuk
mengetahui lebih lanjut, coba kamu perhatikan yang berikut ini.
• Menu Bar terdiri dari perintah menu untuk mengendalikan program.

Di dalam jendela Microsoft Word terdapat kontrol menu yang terletak
pada Title Bar atau baris judul. Kontrol menu tersebut, yaitu Maximize, Mini-
mize, Restore, dan Close.

Gambar 1.4 Tampilan Layar Dokumen Microsoft Word

Perhatikan tabel perintah kontrol menu dan fungsinya berikut ini.
Tabel 1.1 Fungsi tombol-tombol kontrol menu Microsoft Word

Close

Minimize

Restore
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Gambar 1.6 Tampilan toolbar Standar

• Toolbar Standard terdiri dari gambar atau ikon yang berfungsi untuk
membuka dokumen, menyimpan dokumen, dan sebagainya.

Redo Membatalkan proses undo

Ikon           Fungsi

New Blank
Document

Open

Save

E-mail

Printer

Print Preview

Spelling and gram-
mar

Research

Cut

Copy

Paste

Format Painter

Undo

Membuka dokumen kosong yang baru

Membuka file yang telah disimpan

Menyimpan data ke hard disk atau ke media lain

Menulis atau mengirim e-mail

Mencetak dokumen ke printer

Menampilkan tampilan cetak

Memeriksa ejaan

Mencari informasi lebih dalam mengenai Word

Menyalin teks yang dipilih ke clipboard

Memindahkan teks yang dipilih ke clipboard

Menempatkan teks yang ada di clipboard ke posisi yang
diinginkan

Menyalin format teks yang dipilih  ke tempat yang
ditentukan

Membatalkan perintah

Tabel 1.2 Daftar Ikon Toolbar Standard dan fungsinya
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• Toolbar Formating terdiri dari gambar atau ikon yang berfungsi untuk
mengatur format dokumen.

Gambar 1. 7 Tampilan baris Toolbar Formating

Insert Hyperlink

Tables and Borders

Insert Table

Insert Microsoft
Excel Worksheet

Columns

Drawing

Document Map

Show/Hide

Zoom

Microsoft Office
Word Help

Menyisipkan Hyperlink

Membuat tabel dan garis sesuai keinginan

Menyisipkan tabel

Menyisipkan lembar kerja Microsoft Excel ke dalam
Word

Membuat kolom dokumen

Menampilkan toolbar Drawing

Menampilkan peta gambar

Menampilkan atau menyembunyikan tanda paragraf

Mengatur perbesaran tampilan layar dokumen

Meminta bantuan yang diperlukan jika terjadi kesulitan

Ikon        Fungsi

Memilih jenis heading dokumen

Mengubah jenis dan bentuk huruf

Style

Font

Tabel 1.3 Daftar Ikon Toolbar Formating dan fungsinya

Font Size

Bold

Mengubah ukuran huruf

Menampilkan huruf tebal
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Toolbar Drawing

Gambar 1.8 Tampilan toolbar Drawing

Italic

Underline

Align Left

Center

Align Right

Justify

Line Spacing

Numbering

Menampilkan huruf miring

Memberi garis bawah

Paragraf dengan posisi rata kiri

Paragraf dengan posisi rata tengah

Paragraf dengan posisi rata kanan

Paragraf dengan posisi rata kiri dan
kanan

Untuk mengatur jarak spasi

Memberikan atau membatalkan
pemberian nomor

Bullets

Decrease Indent

Increase Indent

Borders

Highlight

Font Color

Menampilkan atau menghilangkan
paragraf butir

Memajukan paragraf satu tab

Memundurkan paragraf satu tab

Menambahkan garis batas

Memberikan warna latar huruf

Memberi dan memilih warna huruf

Ikon                               Fungsi

Drawing Mengatur objek hasil pembuatan

Tabel 1.4 Daftar Ikon Toolbar Drawing dan fungsinya
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AutoShapes

Select Object

Lines

Arrow

Rectangle

Oval

Text Box

Fill Color

Line Color

Font Color

Line Style

Dash Style

Arrow Style

Shadow Style

3-D Style

Menampilkan menu AutoShapes

Memilih objek

Membuat garis

Membuat garis berujung panah

Membuat bingkai berbentuk segiempat

Membuat bingkai berbentuk lingkaran atau
oval

Menempatkan kotak text pada dokumen

Mengatur warna isi bingkai atau kotak teks

Mengatur warna garis atau bingkai

Mengatur warna huruf

Mengatur ketebalan garis

Mengatur model tampilan garis

Mengatur bentuk dan arah tanda panah

Memberikan efek bayangan pada objek

Memberikan 3 dimensi pada obyek yang
dipilih

F. Mengenal Tombol-tombol Keyboard dalam Microsoft Word

Saat menjalankan program Microsoft Word, kamu dapat menggunakan
keyboard untuk memudahkanmu dalam mengoperasikannya. Adapun setiap
tombol memiliki fungsi masing-masing.

Tombol Pengendali Kursor
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G. Menampilkan Menu Help

Menu Help memuat perintah-perintah untuk menampilkan bantuan.
Untuk menampilkan perintah-perintah dapat kamu lakukan dengan dua cara,
yaitu mengklik menu yang bersangkutan dan menekan tombol shortcut di
keyboard. Tombol shortcut sebuah menu ditandai dengan garis bawah pada
menu tersebut.  Sebagai contoh, menu File akan ditulis File, dengan huruf F

Tombol Keyboard                               Fungsi

Up Memindahkan kursor ke atas

Down Memindahkan kursor ke bawah

Left Memindahkan kursor ke kiri

Right Memindahkan kursor ke kanan

Page up

Page down

Tab

Delete Menghapus pengetikan

Backspace

Enter

Shift

Caps Lock

Memindahkan kursor satu halaman layar ke atas

Memindahkan kursor satu halaman layar ke bawah

Memindahkan kursor ke posisi tabulator berikutnya

Menghapus lambang hasil pengetikan di sebelah kiri kursor

Memindahkan suatu baris ke baris berikutnya

Mengatur tombol keyboard lainnya

Membuat huruf besar jika ditekan

Berikut adalah tombol-tombol keyboard yang dapat kamu gunakan untuk
mengoperasikan Microsoft Word.

Tabel 1.5 Daftar Tombol-tombol keyboard dan fungsinya
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H. Menutup atau Keluar dari Program Microsoft Word

Saat menutup program Microsoft Word dapat dilakukan dengan dua
cara. Cara pertama, yaitu dengan mengklik tombol close yang berada di
pojok kanan atas. Cara yang kedua, yaitu pilih menu File, kemudian klik
Exit.

yang diberi garis bawah maka tombol shortcut untuk menu File adalah Alt +
F. Jika kamu menekan tombol Alt dan tombol F secara bersamaan, perintah-
perintah di menu File akan ditampilkan.

Pada saat daftar perintah dari sebuah menu ditampilkan, kamu dapat
melihat bahwa beberapa perintah dilengkapi dengan gambar.  Gambar tersebut
akan membantu untuk mengenali fungsi perintah tersebut. Gambar yang
terdapat di perintah tersebut akan sama dengan gambar yang terdapat pada
tombol toolbar yang mewakili perintah tersebut. Perintah yang mempunyai
gambar di sampingnya juga menandakan bahwa perintah tersebut mempunyai
tombol di toolbar.

Sama halnya dengan menu, perintah yang terdapat dalam sebuah menu
akan dijalankan apabila kamu mengkliknya. Di samping itu, perintah-perintah
tersebut juga mempunyai shortcut yang dapat dijalankan dengan cara menekan
tombol keyboard.

Selain itu, beberapa perintah juga mempunyai tombol shortcut kedua
yang ditampilkan di sebelah kanan perintah tersebut.  Misalnya, perintah Print,
mempunyai perintah shortcut Ctrl + P.

Gambar 1.11 Tampilan menu Help
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Jendela Tips

Untuk mengakhiri
program Microsoft
Word secara cepat,
kamu bisa
menekan tombol
Ctrl + F4

Gambar 1.12 Menutup program Microsoft Word

2

1

I. Prosedur Keselamatan Kerja
Saat menggunakan perangkat teknologi informasi terutama komputer,

kamu harus tetap menerapkan prinsip-prinsip Kesehatan dan Keselamatan
Kerja (K3), sehingga kamu tetap sehat dan terhindar dari kejadian yang tidak
diinginkan.

Kesehatan dan Keselamatan Kerja (K3), adalah suatu aspek yang harus
pertama kali menjadi perhatian setiap melakukan kegiatan apapun, termasuk
ketika berkerja dengan komputer. Penelitian telah mengungkapkan bahwa
bekerja dengan komputer dapat menyebabkan gangguan kesehatan bahkan
keselamatan. Oleh karena itu, K3 merupakan aspek yang harus menjadi
perhatian apabila bekerja dengan komputer.

Penelitian yang sudah dilakukan menyimpulkan bahwa pengguna
komputer dapat menderita nyeri kepala, nyeri otot, dan tulang terutama bahu,
pergelangan tangan, leher, punggung, dan pinggang bagian bawah. Selain itu,
penggunaan komputer juag masih dapat terserang penyakit lain seperti
kesemutan, badan bengkak, anggota badan kaku, sakit ginjal, mata merah,
berair, nyeri, dan bahkan ganguan penglihatan.

Beberapa hal yang bisa dilakukan untuk terhindar resiko bekerja dengan
komputer adalah sebagai berikut.
1. Aturlah posisi tubuh saat berkerja denagn komputer sehingga merasa

aman.
2. Aturlah posisi perangkat komputer dan ruangan sehingga memberi rasa

nyaman.
3. Makan, minum dan istirahatlah yang cukup. Jangan menahan-nahan

buang air kecil karena terlalu asyik berkerja dengan komputer.
4. Sesekali gerakanlah badan untuk megurangi ketegangan otot dan pikiran.

Olahragalah secara teratur.
5. Sesekali alihkan pandangan ke luar ruangan untuk relaksasi mata.
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Posisi tubuh saat berkerja dengan komputer sangat berpengaruh pada
kesehatan. Dengan mengetahui posisi tubuh yang memenuhi syarat K3, maka
dapat mengatur posisi komputer dan penunjang agar dapat memberikan rasa
nyaman.

a. Posisi Kepala dan leher
    Pada saat berkerja dengan komputer, posisi kepala dan leher harus tegak
dengan wajah menghadap langsung ke layar monitor. Leher tidak boleh
membungkuk atau menengadah karena hal ini dapat menyebabkan sakit pada
leher.

b. Posisi Punggung
    Posisi punggung yang baik saat menggunakan komputer adalah posisi
punggung yang tegak, tidak miring ke kiri atau ke kanan, tidak membungkuk
dan tidak bersandar terlalu miring ke belakang. Untuk mendapatkan posisi
punggung yang baik, seharusnya ditunjang dengan tempat duduk yang baik
dan nyaman.

c. Posisi Pundak
    Posisi pundak yang baik adalah posisi pundak yang tidak terlalu terangkat
dan tidak terlalu ke bawah. Bila otot-otot di bahu masih tegang, ini berarti
posisi pundak belum benar.

d. Posisi Lengan dan siku
    Posisi lengan yang baik adalah apabila dapat mengetik dan menggunakan
mouse yang nyaman. Masing-masing orang mempunyai posisi nyaman
tersendiri. Posisi lengan yang baik adalah bila tangan berada di samping badan,
dan siku membentuk sudut yang lebih besar dari 90 derajat.

e. Posisi Kaki
    Pada saat berkerja dengan komputer, kaki harus dapat diletakan di lantai
atau sandaran kaki dengan seluruh tapak kaki menyentuh lantai dan siku
yang membentuk sudut tidak kurang dari 90 derajat.

Selain menerapkan K3, kamu juga harus memerhatikan keamanan dan
keselamatan data. Keamanan merupakan suatu kebutuhan mendasar, demi
keselamatan data atau informasi dan kenyamanan dalam pemakaian  sistem
komputer. Data atau informasi penting yang ada dalam komputer perlu
dilindungi dari user yang tidak berhak mengaksesnya. Selain itu, keamanan
sistem komputer juga bermanfaat untuk menjaga agar komputer tetap nyaman
digunakan terutama dari gangguan virus.

Kamu juga perlu mengetahui ancaman apa saja yang dapat mengganggu
keamananan dan kenyamanan sistem komputermu, serta cara infeksinya dan
bagaimana cara mengantisipasinya supaya tidak menjadi korban. Salah satu
ancaman yang perlu diwaspadai adalah virus. Penyebaran virus dapat
ditularkan melalui media Disket, CD-Room, UFD (USB Flash Disk). Untuk
mengantisipasinya, kamu harus menginstal antivirus pada komputermu.
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Aktivitasku

Coba kamu buka program Microsoft Word dengan langkah-langkah yang sudah kamu
pelajari. Setelah program Microsoft terbuka, coba kamu tutup kembali dengan langkah-
langkah yang sudah kamu pelajari.

Rangkuman

Microsoft Word adalah program aplikasi pengolahan kata (word processor) yang
sangat mudah dipakai, bersifat fleksibel dan mudah diintegrasi dengan program
aplikasi lainnya.
Program pengolahan kata Microsoft Word mengeluarkan versi 1.0 sampai 6.0
versi DOS yang berarti program ini bekerja pada sistem DOS. Microsoft Corpo-
ration mengeluarkan 12 versi Microsoft Word antara lain:
- Microsoft Word versi ‘95
- Microsoft Word versi ‘97
- Microsoft Word versi 2000
- Microsoft Word versi 2002
- Microsoft Word versi 2003
- Microsoft Word versi 2007
Elemen-elemen lembar kerja Microsoft Word :
- Baris judul ( Title Bar)
- Baris Menu ( Menu Bar)
- Baris Toolbar ( Toolbars)
- Tombol Ukuran ( Sizing Button )
- Task Pane
- Baris Penggulung ( Scroll Bar )
- Titik Sisip ( Insertion Point )
- Garis Mistar Mendatar ( Ruler )
Untuk menampilkan baris toolbar lain, pilih dan klik menu View > Toolbars,
kemudian pilih dan klik baris toolbar yang anda inginkan.
Saat menggunakan perangkat teknologi informasi terutama komputer, kamu
harus tetap menerapkan prinsip-prinsip Kesehatan dan Keselamatan Kerja.
Data atau informasi penting yang ada dalam komputer perlu dilindungi dari
user yang tidak berhak mengaksesnya.
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Refleksi

Kamu sudah mempelajari menu dan ikon Microsoft Word. Agar lebih tahu dengan
menu dan ikon Microsoft word, kamu harus sering berlatih menggunakan program
Microsoft Word. Pahami betul fungsi dari setiap menu dan ikon karena menu dan ikon
tersebut akan memudahkanmu saat menjalankan Microsoft Word.

1.  Gambar ikon di samping disebut ....
a. Line c. Font

b. Justify d. Font Color
2. Gambar ikon pada nomor 1 berfungsi sebagai....

a. Mengubah jenis bentuk tulisan
b. Mempertebal tulisan
c. Mewarnai huruf
d. Menampilkan paragraf berbutir

3. Fungsi dari ikon undo adalah....
a. Membatalkan perintah
b. Menampilkan Toolbar Drawing
c. Menyimpan dokumen
d. Membuka file yang telah disimpan

4.  ikon di samping bernama....
a. Style c. Redo
b. Bullets d. Undo

5. ikon  yang bernama Insert Hyperlink yaitu....

a. c.

b. d.

6. Gambar ikon ini bernama...

a. Paste c. Document Map
b. Cut d. Research

7. Pada gambar nomor 6 ikon tersebut berfungsi untuk...

Uji Kompetensi

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

a. Membuat kolom pada dokumen
b. Beralih ke tampilan cetak
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c. Mencari informasi lebih dalam mengenai word
d. Menampilkan peta gambar

8. Ikon yang berfungsi memberi bantuan saat terjadi kesulitan dalam Word adalah....

a. c.  

b. d.

9. Perhatikan ikon atau toolbar di bawah

1.

2.

3.

4.

Ikon-ikon di atas yang termasuk Toolbar Standar yaitu....
a. 1, 2, 3 c. 1, 2, 4
b. 2, 3, 4 d. 1, 3, 4

10.

Gambar di atas merupakan gambar....
a. Menu Bar
b. Toolbar Formatting
c. Toolbar Standar
d. Toolbar Drawing

B.  Jawablah pertanyaan-pertanyaan di bawah ini dengan benar!
1. Bagaimana cara mengaktifkan program Microsoft Word?
2. Apakah fungsi dari Toolbar Drawing?
3. Sebutkan macam-macam toolbar menu!
4. Menu apa saja yang terdapat di Toolbar Standard!
5. Menu apa saja yang terdapat di Toolbar Formating!
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Bab

2

Microsoft Word dapat digunakan untuk membuat berbagai dokumen,
seperti surat, esai, dan lain sebagainya. Jika sudah bisa membuat dokumen
dengan Microsoft Word, kamu juga harus bisa mengedit dokumen yang
kamu buat. Untuk mengedit dokumen, kamu harus mengetahui cara-cara
melakukan pengeditan dalam Microsoft Word. Nah, agar kamu dapat
melakukan pengeditan dengan baik, pelajari bab ini dengan baik.

Membuat dan Mengedit
Dokumen Microsoft Word

Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) memblok teks menggunakan mouse;
2) membuat dokumen dan menyimpan dokumen Microsoft Word;
3) mengedit dokumen Microsoft Word.
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Peta Konsep

Membuat dan Mengedit Dokumen
Microsoft Word

Mengedit dan Memformat
Teks Dokumen
Microsoft Word

Variasi Teks
Menggunakan

WordArt

Mengatur Ukuran
Kertas

Mengatur Margin
dan Orientasi
Percetakan

Mencetak ke Printer

Menggunakan
Mouse

Memblok Teks
Dokumen

Mengenal
Keyboard Shortcut

Menyimpan
Dokumen

Mengenal
Toolbar Save As

Menampilkan Tanda
Paragraf dalam

Dokumen

Menampilkan
Template pada

Dokumen

Kata Kunci

• Mouse
• Drag and Drop
• Shortcut
• Document

• Drive
• Folder
• Margin
• Icon
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A. Cara Menggunakan Mouse

Gambar 2.1 Cara menggunakan mouseGanbar 2.2. Cara mendrag dan mendrop dengan mouse

B. Memblok Teks Menggunakan Mouse

Dalam program Microsoft Word, penggunaan mouse sangat berperan
penting. Untuk itu, perhatikan petunjuk penggunaan mouse di bawah ini.

Dokumen dapat dimodifikasi sesuai  kebutuhan. Adapun caranya, yaitu
dengan memindahkan, menyalin, atau mengganti kata tertentu. Untuk
mengatur tampilan teks, kamu harus memilih atau menyorot teks tertentu
terlebih dahulu.

Untuk memblok teks dapat menggunakan mouse, keyboard atau
kombinasi keduanya, tergantung dari banyaknya teks yang ingin diblok.

Untuk memindahkan atau menyalin teks dalam daerah pengetikan akan
menjadi lebih cepat dengan cara menggeser mouse (Drag & Drop).

Klik kanan

Klik kiri Double klik
Klik kemudian tekan Drop (lepas)

Drag(geser)

1.

2.

3.

Gambar 2.3 Contoh-contoh tampilan memblok dokumen
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1. Untuk memilih satu kata seperti pada gambar no.1, klik dua kali pada
kata yang kamu pilih.

2. Untuk memilih satu kalimat seperti pada gambar No. 2, klik dua kali
kemudian drag.

3. Untuk memilih semua kalimat seperti pada gambar No. 3, klik tiga kali
pada awal teks.

Kamu juga bisa memblok teks dengan menggunakan tombol-tombol
keyboard. Adapun caranya adalah sebagai berikut.

- Tempatkan kursor di awal teks kemudian tekan Shift + panah.
- Tempatkan kusor di awal teks kemudian tekan Shift + End.
- Untuk memblok teks secara keseluruhan, tempatkan kursor di awal teks

kemudian tekan Ctrl + A.

Selain menggunakan mouse, kamu dapat memformat teks dengan tombol-
tombol dalam keyboard. Kunci shortcut berfungsi untuk menentukan perintah
menggunakan keyboard.

C. Keyboard Shortcut

Ctrl+U

Ctrl+I

Ctrl+B

Ctrl+C

Ctrl+V

Ctrl+X

Ctrl+Z

Ctrl+N

Memberikan garis bawah pada teks

Mengubah tulisan menjadi miring

Menebalkan tulisan huruf atau teks

Mengcopy teks atau objek

Menempatkan teks atau objek yang sudah di Copy

Memindahkan suatu teks atau objek

Melakukan Undo

Membuat dokumen baru

Ctrl+A

Ctrl+S

Ctrl+Y

Memblok semua teks dari awal hingga akhir

Menyimpan dokumen

Melakukan Redo atau pembatalan Undo

Shortcut           Fungsi

Tabel 2. 1 Daftar tombol keyboard dan fungsinya



Membuat Dokumen dan Mengedit Dokumen Microsoft Word 21

Ctrl+O

Ctrl+W

Ctrl+D

Membuka dokumen

Menutup dokumen

Mengubah format karakter

Untuk menyimpan dokumen yang sudah kamu buat, perhatikan langkah-
langkah berikut.
• Pilih dan Klik menu File > Save atau klik tombol Save maka kotak

dialog Save As akan muncul seperti gambar berikut.

• Pilih drive dan folder tempat
kamu menyimpan file.

• Ketik nama kamu pada kotak
file name.

• Kemudian klik tombol Save.
• Berikut ini adalah toolbar dalam

Save As.

Jendela Tips

Untuk
membuka
kotak
dialog
secara
cepat, kamu
bisa
menekan
tombol
Ctrl+S

D. Menyimpan Dokumen

Gambar 2. 4 Tampilan menu File

Gambar 2. 5 Tampilan kotak dialog Save As



Teknologi Informasi dan Komunikasi VIII SMP22

Untuk menampilkan tanda-tanda paragraf pada lembar kerja kamu, ayo
ikuti langkah-langkah berikut ini.
• Bukalah dokumen baru program Microsoft Word.
• Kemudian ketiklah naskah sampai selesai.

E. Menampilkan Tanda Paragraf dalam Dokumen

Kembali pemilihan drive atau folder sebelumnya

Naik satu level ke level folder di atasnya

Membuka Web Browser yang terpasang di komputer

Back To

Up One Level

Search the Web

Delete Menghapus file yang sedang dipilih

Membentuk dan membuka folder baru

Mengelola file seperti menghapus, mengganti nama, dll

Mengatur tampilan drive atau folder menurut kategori
tertentu

Create New Folder

Views

Tools

Ikon      Perintah          Fungsi

Tabel 2. 2 Daftar perintah dan fungsinya dalam kotak dialog Save As

Gambar 2.5. Memulai latihan pengetikan.
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• Setelah selesai mengetik, klik tombol toolbar  maka tampilan lembar
kerja kamu akan seperti gambar berikut.

Gambar 2.6 Lembar kerja setelah tanda paragraf ditampilkan.

Jika kamu ingin menampilkan Template dalam dokumen, caranya adalah
sebagai berikut.
• Pilih dan klik menu File New, Kemudian Task Pane New Document

akan muncul seperti gambar di bawah.

F. Cara Menampilkan Template dalam Dokumen

Gambar 2. 7 Menampilkan Template pada dokumen
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• Klik On My Document pada Task Pane New Document dan  klik Tab
Letters & Faxes.

• Beri tanda atau klik tombol Template. Misalkan untuk membuat surat,
pilih dan klik Contemporary Letter.

• Pada kotak Create New, klik tombol Template.
• Klik OK.

Gambar 2. 8 Kotak dialog Template Contamporary & Faxes

Gambar 2. 9 Tampilan dokumen dari Template

Setelah kamu melakukan langkah-langkah tersebut, maka lembar kerja
kamu akan berubah menjadi seperti gambar di bawah.
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G. Mengatur Format Karakter

Gambar 2. 10 Dokumen yang belum diubah

Untuk mengatur format karakter, kamu dapat melakukannya dengan
cara berikut.
• Pilih atau sorot karakter/teks yang akan kamu format, kemudian atur

formatnya sesuai keinginan.
• Tempatkan titik sisip pada posisi awal pengetikan teks, atur formatnya

kemudian ketik teks yang anda inginkan. Maka semua teks yang kamu
ketik mulai dari posisi titik sisip akan mengikuti format yang kamu buat.

Adapun untuk mengatur format karakter teks, kamu dapat menggunakan
Toolbar Formating. Untuk melakukannya, ikuti langkah berikut ini.
• Pilih dan blok karakter/teks yang akan diatur formatnya.
• Pilih dan klik tombol toolbar format karakter yang terdapat toolbar for-

matting.

Aktivitasku

Coba kamu lakukan hal-hal berikut.
- Buatlah dokumen baru Microsoft Word.
- Coba kamu tampilkan tanda paragraf dalam dokumen yang kamu buat.
- Setelah itu, coba tampilkan template dalam dokumenmu.
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Gambar 2.11 Dokumen yang sudah diformat

Aktivitasku

Coba kamu lakukan langkah-langkah berikut ini.
- Carilah sebuah teks di majalah dan ketiklah dengan MS. Word.
- Kemudian format Teks dengan ketentuan berikut.

Font Size Judul = 16
Font Size Teks = 12
Font = Comic Sans MS
Setiap awal paragraf menggunakan Tab
Judul menggunakan Bold, Italic, Underline
Perataan Teks Judul =  Center

H. Variasi Teks Menggunakan Word Art

Untuk memperindah tampilan lembar kerja atau dokumen, kamu dapat
melengkapinya dengan berbagai bentuk variasi teks. Untuk membuat variasi
teks,  kamu dapat menggunakan fasilitas Word Art. Adapun langkah-langkah
membuat variasi teks, yaitu sebagai berikut.
• Pilih dan klik menu Insert.
• Klik menu Picture dan pilih menu WordArt.

Selain cara tersebut, kamu dapat melakukannya dengan langkah seperti
berikut.
• Pilih menu Insert.
• Pilih menu Picture.
• Kemudian pilih menu WordArt dan klik.
• Pilih dan klik gaya tampilan teks pada kotak dialog WordArt yang kamu

inginkan (Word Style), kemudian klik OK.
• Ketik teks yang kamu inginkan pada kotak isian teks.
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Gambar 2. 12 Tampilan menu Insert

Gambar 2.13.Kotak Dialog WordArt

Gambar 2.14 Kotak isian teks

Gambar 2. 14 Hasil tulisan menggunakan
WordArt
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I. Mengatur Ukuran Kertas

Tata letak halaman sangatlah penting karena berhubungan dengan ukuran
kertas, orientasi percetakan, pengaturan margin, pemakaian nomor halaman,
dan pemakaian header dan footer. Berikut adalah langkah-langkah untuk
mengatur ukuran kertas.
• Pilih dan klik menu File kemudian Page Setup.
• Maka akan muncul kotak dialog Page Setup.
• Klik Tab Paper.
• Pada daftar pilihan Paper Size, pilih dan klik ukuran kertas yang kamu

inginkan atau menggunakan kotak Weidht untuk menentukan lebar kertas
dan kotak Height untuk menentukan tinggi kertas.

• Pada daftar pilihan Apply To, pilih dan klik bagian lembar kerja yang
akan memakai ukuran kertas dan orientasi yang baru.

Aktivitasku

Coba kamu lakukan langkah-langkah berikut.
- Buatlah kalimat seperti di bawah ini.

“Belajar Komputer itu menyenangkan”
- Ubah kalimat tersebut dengan menggunakan WordArt.
- Simpanlah hasil pekerjaanmu.

Gambar 2. 15 Tampilan menu File

Jendela Tips

Untuk membuka
menu file secara
cepat, kamu
dapat
menggunakan
tombol Alt + F
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Gambar 2. 16 Kotak dialog Page Setup

Margin merupakan jarak antara tepi daerah pengetikan teks dengan
halaman kertas. Pengaturan margin akan berlaku untuk seluruh lembar kerja,
kecuali jika telah dipilih teks tertentu untuk membagi lembar kerja ke dalam
beberapa bagian. Perhatikanlah langkah-langkah berikut ini.
• Pilih dan klik menu File kemudian Page Setup maka kotak dialog Page

Setup akan muncul.
• Pada bagian Margins, tentukan jarak batas margin yang kamu inginkan.
• Pada bagian Orientation, pilih dan klik salah satu kotak pilihan berikut.

- Portrait : Penempatan dokumen dengan posisi tegak.
- Landscape : Penempatan dokumen dengan posisi tidur

• Pada bagian daftar pilihan Multiple Pages untuk membagi kertas menjadi
beberapa halaman.

• Pada bagian Apply To, pilih dan klik bagian lembar kerja yang akan
memakai batas margin baru.

J. Mengatur Margin dan Orientasi Percetakan

Berikut ini adalah perintah-perintah yang terdapat dalam kotak dialog
Page Setup.

Pengaturan untuk seluruh halaman

Pengaturan berlaku mulai dari bagian ini

Pengaturan berlaku pada teks yang dipilih

Whole Document

This Point Forward

Selected Text

Perintah Fungsi

Tabel 2. 3 Daftar perintah-perintah kotak dialog Page Setup dan fungsinya
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Portrait

Landscape
Multiple Pages

Apply To

Gambar 2. 17 Kotak dialog Page Setup

Jika kamu memilih penempatan dokumen dalam bentuk portrait maka
dokumen akan ditampilkan dalam bentuk vertikal, sedangkan jika kamu
memilih penempatan dokumen dalam bentuk landscape, maka dokumen akan
ditampilkan secara horizontal.

Gambar 2. 18 Tampilan dokumen dalam bentuk portrait
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Gambar 2. 18 Tampilan dokumen dalam bentuk landscape

Saat kamu menyimpan dokumen MS. Word untuk pertama kalinya, secara
otomatis akan terbuka folder My Document. Apabila kamu tidak menginginkan
dokumenmu tersimpan di My Document, karena mungkin kamu ingin membuat folder
dengan nama sesuai kenginanmu, kamu bisa melakukan cara berikut ini.
1. Simpan dokumenmu dengan mengetik Ctrl+S.
2. Arahkan pilihan Save in pada drive yang kamu tuju.
3. Buatlah folder baru dengan mengklik ikon Create New Folder, kemudian beri

nama sesukamu.
4. Klik Save maka dokumenmu telah tersimpan pada folder yang sesuai dengan

keinginanmu.

Jendela Info

K. Mencetak Dokumen ke Printer

Jika ingin mencetak dokumen ke printer, kamu harus memperhatikan
langkah-langakhnya. Berikut adalah langkah-langkah mencetak dokumen.
• Pilih dan klik menu File kemudian klik menu Print maka kotak dialog

Print akan ditampilkan
• Setelah itu, tentukan pilihan-pilihan dalam daftar-daftar pilihan yang

terdapat dalam kotak dialog Print, klik OK, atau menggunakan tombol
Toolbar Print . 
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Gambar 2. 20.Kotak Dialog Print

Gamba 2.19. Tampilan menu File

Pada kotak dialog print, kamu dapat menentukan jenis kertas pada menu
properties. Pada toolbox Page Range, kamu dapat menentukan halaman
yang akan diprint. Jika kamu ingin mencetak dokumen dalam jumlah banyak,
kamu dapat menggunakan toolbox copies, kemudian tentukan berapa banyak
dokumen yang akan kamu cetak pada kotak number of copies.
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Rangkuman

- Memindahkan atau menyalin teks dalam daerah pengetikan akan menjadi lebih
cepat dengan cara menggeser mouse (Drag & Drop).

- Untuk melakukan pemilihan (penyorotan) beberapa teks yang letaknya terpisah-
pisah, lakukan pemilihan atau penyorotan teks sambil menekan tombol Ctrl di
keyboard.

- Untuk mengakhiri Microsoft Word dapat mengklik tombol Close yang berada di
pojok kanan atas jendela atau klik dua kali pada ikon kontrol menu yang berada di
pojok kiri atas jendela Microsoft Word.

- Untuk menyimpan dokumen, caranya pilih dan klik menu File > Save As.

Refleksi

Kamu tentu suka menulis, baik itu surat maupun menulis cerita. Untuk membuat
surat maupun cerita, kamu dapat menggunakan program Microsoft Word. Kemudian,
setelah surat atau cerita yang kamu buat selesai, kamu juga harus melakukan
pengeditan. Pengeditan itu ditujukan agar surat yang kamu buat itu rapi. Sering-
seringlah menulis dan mengedit dengan program Microsoft word.

Aktivitasku

Coba kamu kerjakan yang berikut ini.
• Aturlah ukuran kertas pada dokumen yang sudah kamu buat dengan ketentuan

sebagai berikut.
- Ukuran kertas A4,
- Pengaturan berlaku pada teks yang dipilih

• Tentukan marin dan orientasi pencetakan dengan ketentuan sebagai berikut.
- Ukuran kertas A4
- Dokumen di cetak jumlahnya dua
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1. Jika kita mengklik dua kali pada
bagian tombol yang sama pada
mouse di sebut...
a. Single Klik c. Triple Klik
b. Double Klik d. Klik

2.

Perhatikan gambar di atas!
Jika kamu ingin mengeblok seperti
gambar di atas menggunakan key-
board yaitu...
a. Ctrl+W c. Ctrl+O
b. Ctrl+A d. Ctrl+N

3. Fungsi Ctrl+Y yaitu...
a. Menyimpan dokumen
b. Melakukan Redo
c. Menutup dokumen
d. Melakukan Undo

4. Toolbar ini    berfungsi untuk...
a. Menyisipkan angka
b. Menebalkan huruf
c. Menampilkan paragraf

         d. Menampilkan kotak dialog
5. Gambar ikon yang terdapat pada

soal nomor 4 dinamakan...
a. Bold c. Paste
b. Show/Hide d. Paragraf

6. Ikon ini       berfungsi sebagai...
a. Membuat folder baru
b. Menghapus file
c. Mengatur tampilan drive
d. Mengelola file

7. Jika kamu membuat variasi teks, kamu
dapat menggunakan....
a. Drop Cap c. Template
b. Word Art d. Art Word

8. Toolbar yang berfungsi untuk
membatalkan yaitu...
a. Backspace c. Edit
b. Tab d. Undo/Redo

9.

Perhatikan gambar di atas!
Teks di atas di edit menggunakan...
a. Font c. Bold
b. Font size d. Italic

10. Membuka dokumen baru yang masih
kosong dapat dilakukan dengan tombol
....
a. Ctrl+S c. Ctrl+B
b. Ctrl+F10 d. Ctrl+N

Uji Kompetensi

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

B. Jawablah pertanyaan-pertanyaan berikut dengan singkat dan jelas!
1. Apa fungsi dari tombol Maximize, tombol Minimize, tombol Close, dan tombol Re-

store!
2. Jelaskan langkah-langkah menggunakan WordArt!
3. Jelaskan cara menyimpan dokumen!
4. Jelaskan fungsi ikon-ikon dalam kotak dialog Save As!
5. Bagaimana cara mendrag dan mendrop teks atau objek dengan menggunakan mouse!
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Kamu tentu ingin memodifikasi dokumen yang sudah kamu buat,
bukan? Kamu tidak perlu khawatir karena Microsoft Word menyediakan
berbagai macam aplikasinya. Nah, supaya kamu lebih mahir dalam
menggunakan Microsoft Word, khususnya tentang cara memodifikasi suatu
teks, kamu perlu mempelajari bab ini dengan baik.

Memodifikasi Teks dan
Pengetikan Lanjut

Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) mengenal Ikon Bullets and Numberings;
2) menggunakan Footnote and Endnote;
3) menambahkan Border and Shading pada teks;
4) menggunakan Drop Cap.

Bab

3
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Peta Konsep

Memodifikasi Teks dan Pengetikan
Lanjut

Mengenal Ikon Bullets and
Numberings

Menggunakan Footnote and
Endnote

Memformat dokumen dalam
Bentuk Kolom

Menambahkan Bingkai (Border)
pada teks

Menempatkan Garis Mendatar
pada Paragraf

Menggunakan DropCap
(Dropped Capital Letter)

Kata Kunci

• Bullet and Numbering
• Border and Shading
• Shortcut
• Drop Cap

• Microsoft Word
• Columns
• Footnote
• Endnote
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Untuk memberikan karakter butir (bullets) pada suatu paragraf,
perhatikan langkah-langkah berikut ini.
• Blok paragraf yang ingin kamu beri karakter butir atau tempatkan titik

sisip pada baris kosong di tempat kamu akan memulai pengetikan.
• Pilih dan klik menu Format kemudian menu Bullets and Numberings,

maka Kotak dialog Bullets and Numberings akan muncul.
• Klik Tab Bulleted.
• Pilih dan klik jenis karakter butir (bullets) yang kamu inginkan.
• Jika kamu ingin menggunakan bultir yang lain selain yang sudah di

sediakan oleh MS.Word, kamu dapat menekan tombol Cuztomize, maka
kotak dialog Cuztomize Bulleted List akan muncul.

A. Mengenal Ikon Bullets dan Numberings

Jendela Tips

Untuk
membuat
Bullet and
Numbering
dengan cepat
kamu bisa
menggunakan
tombol Ctrl +
Shift + L

Gambar 3.1 Tampilan Menu Format

Kotak dialog Numberings yang berisi pilihan bentuk-bentuk angka, angka
romawi dan huruf yang berfungsi untuk memberi karakter Numbering pada
suatu paragraf. Untuk membuat Numberings, kamu dapat melakukan
langkah-langkah berikut.
• Pilih salah satu bentuk karakter butir yang kamu inginkan pada bagian

kotak Bullets Character.
• Pada kotak Bullets position untuk menentukan posisi penempatan karakter

butir dari margin kiri pada kotak isian Indent At.
• Kotak text Position, menentukan jarak indentasi teks terhadap margin

kiri pada kotak isian Indent At.
• Kotak Preview untuk melihat hasil pengaturan.
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Untuk memperindah tampilan paragraf, kamu dapat melengkapi paragraf
tersebut dengan bingkai (border). Border dapat mengubah kotak yang
mengelilingi paragraf, hanya satu atau beberapa garis yang ditempatkan di
sisi paragraf.

• Jika kamu ingin menempatkan butir berupa gambar (Clip Art),
klik tombol perintah Picture maka kotak dialog Picture Bul-
let akan ditampilkan. Berikut ini adalah contoh tampilan teks
menggunakan Bullet.

Gambar 3. 4 Kotak Dialog
Picture Bullet

Aktivitasku

Coba kamu lakukan langkah-langkah berikut.
- Buatlah rencana atau daftar barang-barang yang ingin kamu beli.
- Kemudian nomori daftar barang-barang yang ingin kamu beli tersebut

menggunakan menu bullets and numberings.

B. Menambahkan Bingkai pada Teks atau Paragraf

Gambar 3. 3 Kotak Dialog Customize
Bullet

Gambar 3.2 Tampilan Kotak Dialog Bullets

Program Aplikasi Microsoft Office
• Microsoft Word
• Microsoft Excel
• Microsoft Power Point
• Microsoft Access
• Microsoft FrontPage
• Microsoft Outlook
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Gambar 3. 5 Kotak Dialog Border and Shading

Berikut ini adalah jenis-jenis bingkai yang terdapat dalam kotak dialog
Border and Shading.

Kamu dapat membuat dokumen kamu tampak lebih indah dengan
menambahkan bingkai. Adapun cara-cara yang dapat kamu lakukan untuk
membuat bingkai, yaitu sebagai berikut.
• Pilih atau sorot paragraf yang akan kamu beri bingkai (border).
• Pilih dan klik menu Format kemudian Borders and Shading.
• Kemudian klik pada Tab Borders. Maka akan muncul kotak dialog Bor-

ders and Shading.
• Pada kotak Setting, pilih dan klik jenis bingkai yang kamu inginkan.
• Pada kotak Style, pilih dan klik jenis garis yang kamu inginkan.
• Pada kotak Color, pilih dan klik warna garis yang kamu inginkan.
• Pada kotak Widht, pilih dan klik ketebalan garis.

Menghilangkan bingkai (border).None

Box

Ikon      Toolbar                                    Fungsi

Memasang bingkai (border) dengan bentuk bingkai

biasa.

Tabel 3. 1 Daftar pilihan Border Setting dalam kotak dialog Border and Shading
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Untuk memperindah tampilan paragraf, kamu dapat menggunakan garis
mendatar hanya pada bagian paragraf.
• Pilih atau sorot paragraf yang akan di beri garis Horizontal Line.
• Pilih dan klik menu Format kemudian pilih menu Borders and Shading

maka akan muncul kotak dialog Borders and Shading.

Gambar 3. 6 Contoh paragraf menggunakan Border

Perhatikan contoh paragraf yang menggunakan Border and Shading
berikut ini.

Shadow

3-D

Custom

Bingkai yang dilengkapi bayangan.

Bingkai tiga dimensi.

Membuat bingkai sendiri melalui kotak.

C. Menempatkan Garis Mendatar (Horizontal Line) pada Paragraf
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Gambar 3. 7 Tampilan menu Format

Gambar 3. 8 Tampilan Kotak dialog Borders and Shading

Gambar 3. 8 Tampilan Kotak
Horizontal Line

• Setelah muncul kotak dialog Borders and Shading, pilih dan klik menu
Horizontal Line maka akan muncul kotak dialog Horizontal Line.

• Pilihlah jenis-jenis Horizontal Line yang telah disediakan.
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Sebelum memformat dokumen dalam bentuk kolom, kamu harus
menentukan bagian dari dokumen yang akan diformat dan posisi penempatan
titik sisip. Untuk itu, perhatikan langkah-langkah berikut ini.
• Pilih atau sorot teks atau paragraf yang akan kamu format ke dalam

bentuk kolom atau tempatkan sisip di tempat yang kamu inginkan.
• Pilih dan klik menu Format > Columns maka akan muncul kotak dialog

Columns.
• Pilih dan klik bentuk format pengetikan kolom yang akan dibuat.
• Pada kotak pilihan Number of Columns untuk menentukan kolom yang

kamu inginkan.

D. Menggunakan Drop Cap (Dropped Capital Letter)

Drop Cap berfungsi membuat huruf kata pertama dalam paragraf tampil
lebih besar dan menarik. Berikut adalah langkah-langkah melakukan Drop
Cap.
• Pilih atau sorot kata pertama dalam paragraf yang ingin dijadikan Drop

Cap.
• Pilih dan klik menu Format kemudian pilih menu Drop Cap maka akan

tampil kotak dialog Drop Cap.
• Pada bagian Position, pilih dan klik bentuk Drop Cap yang kamu  inginkan.
• Pada bagian Options, kamu dapat mengatur Drop Cap.
• Klik OK.

Gambar 3.9 Tampilan menu Format

E. Memformat Dokumen dalam Bentuk Kolom
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Gambar 3. 11 Kotak dialog Columns

Gambar 3.10 Tampilan menu Format

• Kotak pilihan Line Between untuk memberikan garis batas antarkolom.
• Klik OK.
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Di bawah ini adalah contoh teks yang sudah dibuat kolom.

Selain menggunakan cara di atas, kamu dapat membuat kolom dengan

mengklik icon  . Caranya: Blok dahulu text yang akan dibuat berbentuk

multi kolom lalu tekan tombol  .

Gambar 3. 12 Contoh teks yang dibuat kolom

Ayo, perhatikan perintah-perintah yang terdapat dalam kotak Columns berikut.

Daerah pengetikan kolom yang berlaku pada bagian yang kamu pilih.

Daerah pengetikan kolom yang berlaku pada teks yang  kamu pilih

Selected Sections

Perintah                                         Fungsi

Selected Text

This point Forward

This section option

Whole Document

Daerah pengetikan kolom, yang berlaku dari posisi titik sisip sampai
akhir dokumen

Daerah pengetikan kolom yang berlaku pada bagian titik sisip berada

Daerah pengetikan kolom yang berlaku pada seluruh dokumen

Tabel 3. 2 Daftar perintah-perintah dalam kotak dialog Columns
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F. Menggunakan Footnote dan Endnote

Footnote (catatan kaki) merupakan informasi tambahan mengenai suatu
topik dalam dokumen. Footnote biasanya digunakan untuk menempatkan
nomor halaman dokumen dan informasi (catatan kaki). Nomor ini biasanya
ditampilkan dalam format Superscript dan ditempatkan setelah teks. Adapun
isi footnote berisi keterangan yang ditempatkan di bagian bawah halaman
yang sama, dan dipisahkan dari teks utama dokumen oleh suatu garis pemisah,
sedangkan endnote sama dengan footnote, kecuali penempatan isinya yang
berada di halaman terakhir dari dokumen. Untuk memberi footnote pada
dokumenmu, perhatikan langkah-langkah berikut.
• Tempatkan titik sisip di tempat yang akan disisipkan tanda footnote

atau endnote.
• Klik menu Insert > Reference, kemudian pilih Footnote maka kotak

dialog Footnote and Endnote aka tampil.

Gambar 3. 13 Langkah-langkah membuat footnote

Jendela Tips

Untuk
membuka
menu insert
secara
cepat, kamu
dapat
menggunakan
tombol Alt+I

Aktivitasku

- Buatlah sebuah cerita yang menarik.
- Ketiklah cerita tersebut dalam dokumen MS.Word.
- Buatlah hasil ketikan ceritamu menjadi tambah menarik dengan melakukan

pengeditan menggunakan Horizontal Line, Drop Cap, dan membuatnya menjadi
kolom menggunakan Columns.

- Cetak hasil pekerjaanmu kemudian bacakan di depan kelas.
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Untuk menghapus footnote atau endnote dan isinya, kamu harus
menyorot tanda simbol dari footnote atau endnote dengan menekan tombol
Delete atau Backspace.

• Pada kotak Location terdapat pilihan:
- Footnote untuk menyisipkan catatan kaki
- Endnote untuk menyisipkan catatan akhir

• Pada bagian Format terdapat pilihan:
- Number format untuk memberi nomor footnote atau endnote.
- Custom mark untuk memberi tanda lain selain angka, misalnya dengan

simbol.
- Start at untuk menempatkan nomor awal
- Numbering untuk memformat penomoran

Perhatikan contoh teks yang sudah diberi footnote berikut.

• Untuk membuat atau menghapus paragraf berbutir, kamu dapat menggunakan tombol
toolbar bullets.

• Untuk menampilkan atau menghilangkan pemberian nomor pada paragraf, kamu
dapat menggunakan tombol toolbar numbering.

• Tombol toolbar columns merupakan fasilitas yang disediakan untuk membagi
dokumen menjadi beberapa kolom dengan lebar yang sama.

• Untuk menghapus suatu footnote atau endnote berikut dengan isinya, pilih atau
sorot tanda dari footnote atau endnote kemudian tekan tombol delete atau back-
space.

Rangkuman

Gambar 3. 15 Contoh penggunaan Footnote

Gambar 3. 14 Kotak dialog
Footnote and Endnote
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Refleksi

Setelah kamu membuat dokumen dan melakukan pengeditan, kamu dapat
memformat dokumenmu, misalnya menjadi dua kolom atau tiga kolom, atau kamu
juga bisa membuat DropCap. Untuk melatih keterampilanmu dalam memformat
teks atau dokumen, kamu harus benyak berlatih dan mencoba.

Uji Kompetensi

1. Jika kamu mengklik dua kali pada
bagian tombol yang sama pada mouse
disebut...
a. Single Klik c. Triple Klik
b. Double Klik d. Klik

2. Jika ingin menyisipkan tanda butir
pada teks yaitu menggunakan ikon...
a.    Numbering
b. Bullets
c. Decrease Indent
d. Increase Indent

2. Untuk menempatkan garis bawah
dalam paragraf disebut...
a. Drop Cap
b. Horizontal Line
c. Word Art
d. Columns

3. Fungsi dari Footnote and Endnote
yaitu...
a. Membuat huruf menjadi besar
b. Membuat catatan kaki atau

catatan akhir

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

c. Membuat catatan memo
d. Membuat catatan penting

4. Toolbar None pada kotak dialog Bor-
der and Shading berfungsi untuk.....
a. Menghilangkan bingkai
b. Memasang bingkai
c. Menyisipkan Bullets
d. Menyisipkan Horizontal Line

5. Footnote digunakan untuk...
a. Membuat dokumen baru
b. Membuat catatan akhir
c. Membuat catatan kaki
d. Membuat keterangan

6. Untuk memasang bingkai dengan
bayangan dalam border, yaitu....
a. 3-D c. Custom
b. Shadow d. Box

7. Untuk membuat huruf kata pertama
dalam paragraf tampil lebih besar dan
menarik menggunakan....
a. Vertical Line
b. Horizontal Line

• Dengan mengklik tombol perintah Horizontal Line pada kotak dialog Borders and
Shading, kamu dapat memilih dan menempatkan berbagai bentuk garis mendatar
yang menarik.
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B. Jawablah pertanyaan-pertanyaan berikut dengan singkat dan jelas!
1. Jelaskan langkah-langkah untuk memberikan bullet pada paragraf!
2. Bagaimana cara menambahkan bingkai pada paragraf?
3. Apa saja jenis-jenis bingkai yang terdapat dalam kotak dialog Border and Shad-

ing!
4. Jelaskan langkah-langkah menggunakan Drop Cap!
5. Bagaimana cara memberikan footnote pada paragraf yang telah kamu buat?

c. Drop Cap
d. Word Art

8. Selected text dalam kotak dialog col-
umns berarti...
a. Menetukan daerah pengetikan

kolom pada bagian yang di pilih.
b. Menentukan daerah pengetikan

kolom dari titik sisip sampai
akhir dokumen.

c. Menentukan daerah pengetikan
kolom pada teks yang dipilih.

d. Menetukan daerah pengetikan
kolom untuk seluruh dokumen.

9. Border berfungsi untuk...
a. Menambahkan tabel
b. Menambahkan garis
c. Menambahkan kotak
d. Menambahkan Bingkai

10. Shading berfungsi untuk....
a. Menambahkan tabel
b. Menambahkan garis
c. Menambahkan kotak
d. Menambahkan Bingkai
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Kamu tentu sudah bisa membuat dokumen. Nah, untuk memperindah
tampilan dokumen yang sudah kamu buat dapat dilakukan dengan cara
menyisipkan suatu objek. Selain memperindah tampilan, penyisipan objek
juga bertujuan untuk mendukung isi dokumen agar materi yang disajikan
lebih bermakna dan jelas. Dalam bab ini, kamu akan mempelajari
bagaimana cara-cara menyisipkan objek, seperti menyisipkan simbol,
gambar, dan variasi teks. Ayo, pelajari bab ini baik-baik.

Penempatan Objek pada
Dokumen

Bab

4
Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) menyisipkan objek gambar dalam teks;
2) mengkreasikan kalimat menggunakan AutoShapes;
3) membuat struktur organisasi dengan diagram;
4) mengkopi objek dalam jumlah banyak.
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Peta Konsep

Menyisipkan Objek Gambar

Mengkreasikan Kalimat
Menggunakan AutoShapes

Membuat Struktur
Organisasi dengan Diagram

Mengcopy Objek dalam
Jumlah Banyak

Menyisipkan Objek
Menggunakan Autoshapes

Mengatur Clip
Art dengan

Format
Layout

Menyisipkan
Objek

Gambar
dalam Teks

Mengenal
Toolbar
Picture

Penempatan Objek pada
Dokumen

Kata Kunci

• Clip Art
• Insert
• Search
• Shortcut

• Layout
• Autoshapes
• Diagram
• Organization Chart



Penempatan Objek pada Dokumen 51

A. Menyisipkan Objek Gambar

Kamu dapat melengkapi dan memperindah tampilan dokumen dengan
berbagai objek gambar, suara, atau gambar animasi. Untuk mengambil objek
gambar dari Clip Art Gallery, perhatikan langkah-langkah berikut.

Gambar 4. 1 Tampilan menu Insert

Gambar 4. 2 kotak dialog
clip art

• Tempatkan titik sisip di posisi yang kamu inginkan.
• Pilih dan klik menu Insert, kemudian pilih menu Picture.
• Setelah itu,  pilih dan klik menu Clip Art maka jendela Task

Pane-Insert Clip Art akan ditampilkan di sebelah kanan.
• Pada kotak isian Search For, ketiklah kategori gambar, suara

atau gambar animasi yang ingin kamu cari.
• Pada tombol Search in, kamu dapat menentukan lokasi

pencarian objek. Kamu dapat memilih Everywhere, jika kamu
ingin pencarian dilakukan pada semua lokasi.

• Pada tombol daftar pilihan Results Should Be, tentukan jenis
file yang ingin kamu cari. Kamu dapat memilih All Media
file Types apabila pencarian ingin dilakukan ke semua jenis
file

• Untuk memulai pencarian, kamu dapat langsung mengklik
tombol Search.

• Untuk menempatkan gambar, suara atau animasi yang telah
kamu temukan, pilih dan klik gambar yang kamu inginkan.

• Jika kamu bermaksud mencari kategori gambar lain atau
mencari nama file gambar lain, klik tombol perintah pada
kotak isian Search For, kemudian ketik kategori gambar yang
kamu cari.
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Gambar 4. 3 Tampilan hasil penyisipan Clip Art

Kamu dapat mengatur dan menata objek gambar yang sudah kamu
tempatkan dengan menggunakan menu Format > Picture. Perhatikan
langkah-langkah berikut ini.
• Bukalah file kamu yang menggunakan penyisipan objek.
• Tempatkan penunjuk mouse pada gambar yang ingin kamu format.
• Klik kanan pada mouse, kemudian akan tampil menu Shortcut.
• Pilih dan klik menu Format Picture maka kotak dialog Format Picture

akan ditampilkan.

Gambar 4. 4 Tampilan menu Format Picture

B. Mengatur Clip Art dengan Format Layout
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Gambar 4. 5 Kotak dialog Format Picture

• Setelah muncul kotak dialog Format Picture, pilih dan klik Tab     Lay-
out, lalu pilih salah satu layout teks berikut.
- In Line with text : objek gambar ditempatkan di atas teks.
- Square : teks ditempatkan di sekeliling batas bingkai.
- Tight : layout teks menyesuaikan dengan bentuk objek.
- Behind text : objek ditempatkan di belakang teks.
- In front of text : objek ditempatkan di depan teks.

Gambar 4. 6 Tampilan Behind text
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C. Menyisipkan Objek Gambar dalam Teks
Dengan menggunakan Format > Picture, kamu dapat mengatur Layout

objek gambar. Kamu dapat mengatur dan menata objek gambar yang sudah
kamu tempatkan dengan memanfaatkan baris Toolbar Picture.

Untuk menata objek gambar, perhatikan langkah-langkah berikut.
• Pilih dan klik menu View, kemudian pilih menu Toolbars.
• Pilih dan klik menu Picture.
• In Line With Text, objek berada di atas teks.
• Square, objek di sekeliling batas bingkai.
• Tight, teks mengikuti atau menyesuaikan bentuk objek.
• Behind Text, objek berada di belakang teks.
• In front of Text, objek berada di depan teks.
• Top and Bottom, objek berada di atas dan bawah teks.

Gambar 4. 7 Contoh penyisipan gambar

Berikut hasil format Picture Behind Text.

Gambar 4. 8 Hasil penyisipan gambar menggunakan Format Picture
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Toolbar Picture berfungsi untuk mengatur dan menata gambar atau
objek. Berikut ini adalah gambar Panel Picture.

Gambar 4. 9 Toolbar Picture

Untuk menampilkan Toolbar Picture, perhatikan langkah-langkah
berikut.
• Pilih dan klik menu View.
• Kemudian pilih menu Toolbars.
• Pilih dan klik menu Picture.

D. Mengenal Toolbar Picture

- Coba kamu buka dokumen yang sudah kamu buat.
- Sisipkan gambar yang kamu inginkan ke dalam dokumen tersebut.
- Simpan kembali dokumen tersebut dengan nama yang berbeda.

Aktivitasku

Ikon      Toolbar                                    Fungsi

Menyisipkan objek gambar

Mengatur tampilan gambar

Menambah kontras objek

Mengurangi kontras objek

Menambah terang objek

Memilih garis atau bingkai

Menampilkan kotak dialog Format Picture

Insert Picture

Image Control

More Contrast

Less Contrast

More Brightness

Line Style

Format Picture

Memberikan warna latar belakang transparan

Mengembalikan tampilan objek ke bentuk semula

Set Transparent Color

Tabel 4. 1 Daftar Toolbar Picture dan fungsinya

Reset Picture



Teknologi Informasi dan Komunikasi VIII SMP56

E. Menyisipkan Objek Menggunakan AutoShapes

Fasilitas AutoShapes dapat membantu kamu dalam membuat objek-
objek gambar sederhana. Dengan AutoShapes, kamu dapat melengkapi dan
memperindah dokumen. Untuk menyisipkan AutoShapes, perhatikan langkah-
langkah berikut ini.
• Pilih dan klik menu Insert.
• Pilih menu Picture.
• Kemudian pilih dan klik menu AutoShapes maka akan muncul toolbar

AutoShapes.

Gambar 4. 9 Tampilan menu AutoShapes

Gambar 4. 10 Toolbar AutoShapes

Agar kamu dapat mengetahui ikon-ikon  dalam Toolbar AutoShapes
beserta fungsinya, perhatikan tabel berikut.

Membuat garis,berujung panah atau tidak

Membuat garis penghubung bagan arus

Lines

Connectors

Ikon      Toolbar                                    Fungsi

Tabel 4. 1 Daftar Toolbar AutoShapes dan fungsinya
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Kamu juga dapat menyisipkan teks pada objek gambar. Untuk
melakukannya, perhatikan langkah-langkah berikut ini.
• Klik tombol kanan mouse pada objek yang kamu inginkan.
• Maka menu Shortcut akan muncul seperti gambar di bawah.
• Pilih dan klik menu Add Text.
• Kemudian ketik teks yang kamu inginkan pada objek gambar tersebut.

Perhatikan contoh penyisipan teks pada gambar di bawah.

Gambar 4. 11 Cara penyisipan teks pada gambar

Basic Shapes

Block Arrows

Flowchart

Star and Banners

Callouts

More Auto Shapes

Mengambil berbagai variasi shapes yang menarik

Membuat variasi tanda panah berbentuk blok

Membuat bagan arus

Membuat variasi bintang dan banner

Membuat variasi bentuk kotak keterangan

Menampilkan autoshapes lain selain pada toolbar
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F. Mengkreasikan Suatu Kalimat Menggunakan AutoShapes

Fasilitas AutoShapes selain dapat dimanfaatkan untuk membuat objek
gambar, dapat juga digunakan untuk mengkreasikan suatu teks menjadi indah.
Untuk melakukan hal tersebut, perhatikan langkah- langkah berikut ini.
• Pilih dan klik menu Insert.
• Pilih menu Picture.
• Kemudian pilih dan klik menu AutoShapes.
• Atau kamu dapat langsung megklik toolbar AutoShapes.
• Untuk membuat objek gambar, lakukan dengan mengarahkan penunjuk

mouse ke posisi awal penempatan gambar, kemudian drag ukuran sesuai
keinginan.

Gambar 4. 12. Penyisipan teks pada gambar

Selain menggunakan cara di atas, kamu dapat menggunakan fasilitas
AutoShapes dengan menggunakan tombol Toolbar AutoShapes.

Aktivitasku

- Buatlah sebuah cerita yang menarik.
- Sisipkanlah objek dalam teks cerita yang kamu buat.
- Gunakanlah fasilitas Autoshapes.
- Sisipkan teks pada Autoshapes tersebut sesuai keinginanmu.
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Kamu juga dapat menyisipkan teks pada objek gambar kamu. Perhatikan
langkah-langkah berikut ini.
• Klik tombol kanan mouse pada objek yang kamu inginkan maka menu

Shortcut akan muncul.
• Pilih dan klik menu Add Text.

Pehatikan cara menyisipkan teks pada objek gambar AutoShapes
berikut.

Gambar 4. 13 Memilih bentuk yang diinginkan.

Gambar 4. 14. Contoh salah satu bentuk Autoshapes

Gambar 4. 15. Cara  menyisipkan text pada Autoshapes
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Microsoft Word 2003 menyediakan fasilitas diagram dalam beberapa
bentuk diagram. Fasilitas ini biasa digunakan untuk membentuk struktur
organisasi.

Gambar 4. 17  Kotak dialog Diagram Gallery

G. Membuat Struktur Organisasi dengan Diagram

Gambar 4. 16. Contoh kreasi menggunakan Autoshapes

Aktivitasku

1. Buatlah sebuah kalimat atau kata-kata mutiara.
2. Kreasikan kata-kata mutiara kamu dengan menggunakan Autoshapes.
3. Kemudian cetak hasil karyamu.

Untuk membuat struktur organisasi,
perhatikan langkah-langkah berikut ini.
• Pilih dan klik menu Insert.
• Kemudian pilih dan klik menu dia-

gram.
• Atau kamu dapat langsung mengklik

ikon diagram yang terdapat dalam
Toolbar Drawing maka akan
muncul kotak dialog Diagram Gal-
lery seperti gambar di samping.

• Pada kotak dialog Diagram Gal-
lery, pilihlah jenis bentuk diagram
yang disediakan.

• Untuk menyisipkan teks di dalam
diagram kamu hanya mengklik kotak
diagram yang ingin disisipkan teks.
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Gambar di atas merupakan contoh hasil penyisipan teks di dalam dia-
gram. Untuk mengubah bentuk diagram kamu dapat mengklik Layout pada
kotak diagram.

Gambar 4. 20 Kotak dialog Organization Chart

Gambar 4. 19 Hasil penyisipan teks dalam diagram

Gambar 4. 18 Contoh bentuk diagram
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Gambar berikut ini merupakan contoh salah satu bentuk diagram yang
lain yang telah di format menggunakan Organization Chart Gallery.

Gambar 4. 23 Contoh bentuk lain dari diagram

Gambar 4. 22 Diagram setelah di Auto Format

Gambar 4. 21 Kotak Organization Chart Gallery

Gambar di bawah merupakan tampilan diagram setelah diubah
menggunakan Organization Chart Gallery.

Untuk memformat bentuk diagram, kamu dapat mengklik tombol Auto
Format dalam kotak dialog Organization Chart Style Gallery, kamu dapat
memilih bentuk-bentuk diagram sesuai keinginanmu.
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Aktivitasku

Buatlah susunan organisasi OSIS di sekolahmu dengan menggunakan diagram.

Selain menggunakan Insert Table, kamu  juga dapat memanfaatkan
ikon garis dan ikon kotak dalam membuat tabel atau diagram. Perhatikan
langkah-langkah berikut ini.

Tahap 1

Tahap 2

H. Membuat Diagram atau Struktur Organisasi Menggunakan
Line dan Shapes

Tahap 3

Untuk membuat kotak gunakan ikon

Copy

Untuk membuat garis gunakan ikon

Untuk menentukan ukuran garis

Mengcopy
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Gambar 4.24 Tampilan menu menyisipkan tulisan

• Setelah tampilan menu muncul, kemudian sisipkan teks di dalam bagan
tersebut.

• Klik kanan pada mouse.
• Kemudian pilih dan klik menu Add Text. Di bawah merupakan contoh

bagan keluarga.

Gambar 4. 25 Contoh bagan struktur organisasi
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Aktivitasku

Buatlah struktur keorganisasian di dalam kelasmu masing-masing dengan
menggunakan ikon berikut.

1. 2.

I. Mengkopi Objek dalam Jumlah Banyak

Untuk mempercepat kerja saat mengkopi suatu objek, kamu dapat
menggunakan cara berikut.
- Blok semua objek yang ingin di kopi.
- Tekan tombol Ctrl + C, kemudian tekan tombol Ctrl + V di tempat yang

sama.
- Cara lainnya, yaitu kamu juga bisa mendrag objek ke tempat yang kamu

inginkan.

Gambar 4. 26  Proses pertama

Gambar 4. 27 Proses kedua
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Rangkuman

• Untuk mengubah ukuran objek, geser (drag) titik-titik pegangan objek gambarnya.
• Untuk mengatur letak penempatan objek, geser (drag) objek gambar tersebut ke

posisi yang kamu inginkan.
• Untuk menghapus objek gambar, gunakan tombol Delete.
• Fasilitas AutoShapes dengan tombol toolbar AutoShapes berada dalam baris

Toolbar Drawing.
• Untuk membuat objek gambar, lakukan dengan mengarahkan penunjuk mouse

ke posisi awal penempatan gambar, kemudian geser (drag) seluas ukuran gambar
objek.

• Dalam Toolbar AutoShapes terdiri dari:
- Lines untuk membuat garis.
- Connector untuk membuat garis penghubung.
- Basic Shapes untuk mengambil berbagai variasi shapes yang menarik.
- Block Arrows untuk membuat berbagai variasi tanda panah berbentuk blok.
- Flowchart untuk membuat bagan arus (flowchart).
- Stars and Banners untuk membuat berbagai variasi gambar bintang dan

banner.
- Callouts untuk membuat berbagai variasi bentuk kotak keterangan.
- More AutoShapes untuk menampilkan AutoShapes lain selain yang ada

pada baris toolbar.

Refleksi

Kamu tentu merasa senang jika dokumen yang sudah kamu buat disisipi berbagai
objek. Bahkan, foto kamu pun bisa disisipkan untuk mempercantik tampilan dokumen.
Nah, kamu sudah mengetahui cara-cara menyisipkan objek dalam dokumen, bukan?
Kamu harus terus berlatih agar dokumen-dokumen yang sudah kamu buat semakin
bagus.
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Perhatikan gambar di atas!
1. Gambar Toolbar di atas

dinamakan...
a. Toolbar WordArt
b. Toolbar Picture
c. Toolbar AutoShapes
d. Toolbar ClipArt

2. Untuk menampilkan toolbar di atas
harus...
a. Klik Insert > View > Picture
b. Klik View > Picture > Toolbar
c. Klik View > Toolbar > Picture
d. Klik Toolbar > View > Picture

3. Fungsi dari gambar toobar di atas
yaitu...
a. Mengatur dan menata gambar
b. Mengatur dan menata teks
c. Mengatur dan menata tabel
d. Mengatur dan menata grafik

Perhatikan gambar di atas!
4. Toolbar di atas bernama...

a. Toolbar Picture
b. Toolbar ClipArt
c. Toolbar AutoShapes
d. ToolbarWordArt

5. Untuk menampilkan toolbar di atas
harus...
a. Klik Insert > Picture > Auto-

Shapes
b. Klik Insert > AutoShapes >

Picture

Perhatikan gambar di atas!
7. Gambar di atas dibuat menggunakan....

a. WordArt c. Diagram
b. AutoShapes d. Picture

8. Cara menyisipkan teks di dalam gambar,
yaitu dengan cara....
a. Klik kanan > Add Text
b Klik kiri > Add Text
c. Double klik kanan > Add Text
d. Double klik kiri > Add text

9.    Gambar di bawah adalah gambar...

Uji Kompetensi

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

c. Klik File > Picture > AutoShapes
d. Klik File > AutoShapes > Picture

6.         Ikon di samping berfungsi sebagai...

a. Membuat variasi bentuk callouts
b. Membuat variasi gambar bintang
c. Membuat variasi shape yang

menarik
d. Membuat tanda panah berbentuk

blok
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B. Jawablah pertanyaan-pertanyaan berikut dengan singkat dan jelas!
1. Jelaskan langkah-langkah untuk mengambil objek gambar dari Clip Art Gallery!
2. Bagaimana cara mengatur dan menata objek gambar yang sudah kamu tempatkan

dengan menggunakan menu Format Picture?
3. Bagaimana cara menyisipkan objek gambar pada teks?
4. Apa saja tombol-tombol perintah yang terdapat dalam toolbar picture!
5. Apa saja tombol-tombol perintah yang terdapat dalam toolbar autoshapes?

a. kotak dialog AutoShapes
b. kotak dialog Picture
c. kotak dialog Diagram
d. kotak dialog Grafik

10. Untuk membuat objek gambar tetapi juga dapat mengkreasikan suatu teks menjadi indah,
kamu dapat menggunakan....
a. Connectors
b. Autoshapes
c. Flowchart
d. Callouts
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Membuat Tabel pada
Microsoft Word

Microsoft Word merupakan program pengolah kata yang di dalamnya
terdapat berbagai macam aplikasi, salah satunya adalah aplikasi yang dapat
digunakan untuk membuat tabel. Dengan fasilitas pembuatan tabel yang
terdapat pada Microsoft Word, kamu dapat membuat jadwal piket, jadwal
pelajaran, dan lain sebagainya. Kamu tentu ingin mengetahui bagaimana
cara membuat tabel, bukan? Ayo, pelajari bab ini dengan baik.

Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) membuat tabel;
2) menyunting sel, baris, kolom, dan tabel;
3) menghapus sel, baris, kolom, dan tabel;
4) menyisipkan baris atau kolom baru.

Bab 5



Teknologi Informasi dan Komunikasi VIII SMP70

Peta Konsep

Kata Kunci

• Columns
• Table
• Cell
• Microsoft Excel

• Autoformat
• Row
• Border
• Worksheet

Membuat Tabel dalam
Microsoft Word

Membuat Tabel

Membuat Tabel dengan
Menggambarnya

Memformat Tabel

Menyunting Sel, Baris,
Kolom, dan Tabel

Menghapus Sel, Baris,
Kolom, dan Tabel

Menyisipkan Baris
atau Kolom Baru

Membuat Tabel dengan
Menyisipkan Microsoft

Excel
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A. Membuat Tabel

Microsoft Word 2003 menyediakan berbagai alternatif untuk
menempatkan tabel pada dokumen.
• Tempatkan titik sisip di posisi yang diinginkan.
• Pilih dan klik menu Table, kemudian pilih dan klik menu Insert Table

maka kotak dialog Insert Table akan muncul seperti gambar di bawah.

Gambar 5. 1 Cara membuat tabel

Gambar 5. 2. Kotak Dialog Table

• Pada kotak Number of Columns, kamu dapat menentukan jumlah kolom
yang kamu inginkan.
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Untuk membuat tabel dengan melalui  Toolbar Insert Table, langkah-
langkah yang dapat kamu lakukan, yaitu sebagai berikut.
• Tempatkan titik sisip di posisi tabel akan kamu tempatkan
• Klik tombol Toolbar Insert table  pada baris Toolbar Standart, geser

(drag) mouse ke kanan sebanyak kolom yang kamu inginkan untuk
disisipkan dan ke bawah sebanyak yang akan kamu sisipkan.

Gambar 5. 3 Contoh hasil layout tabel

Gambar 5. 4 Contoh tabel perbandingan nilai

Perhatikan contoh tabel perbandingan nilai di bawah ini.

Gambar-Gambar di atas merupakan tampilan tabel menggunakan In-
sert Table. Masih banyak cara membuat tabel dalam Microsoft word 2003.
Selain menggunakan Insert table, dapat juga dengan mengklik ikon Insert
table , dengan Draw Table dan menyisipkan lembar kerja Microsoft Excel.
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Gambar 5. 5  Menempatkan tabel menggunakan toolbar Insert Table

Aktivitasku

1. Buatlah sebuah tabel menggunakan Toolbar Insert Table.
2. Isilah tabel tersebut sesuai ketentuan berikut.

- Pada kolom atas Nama, Alamat, Tempat Tinggal, Nomor Telepon.
- Berilah judul “Biodata Teman-Teman”.

Gambar 5. 6 Hasil penempatan tabel menggunakan toolbar Insert Table
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Kamu dapat memformat tabel dengan
mengklik tombol AutoFormat yang telah di
sediakan oleh Microsoft Word.  AutoFormat
menyediakan bentuk-bentuk tabel yang
disediakan oleh Microsoft Word.

Sebelum membuat tabel, pilih bentuk tabel
dalam kotak Table style. Pada kotak daftar
pilihan Table Styles, pilih dan klik format table
yang diinginkan. Kemudian hasilnya dapat
kamu lihat pada kotak Preview.

Gambar di bawah merupakan tampilan
hasil tabel yang sudah diformat menggunakan
AutoFormat.

Gambar 5. 7 Kotak dialog Table AutoFormat

Gambar 5. 8. Contoh bentuk table contemporary dalam AutoFormat

B. Memformat Tabel
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- Buatlah tabel mata pelajaran kemudian isilah tabel tersebut dengan mata pelajaran
kamu.

- Tempellah di meja belajarmu.
- Buatlah sebuah data yang menggunakan tabel.
- Kerjakanlah tabel tersebut dalam MS.Word.

Dalam Microsoft word 2003, kamu juga dapat menggambar tabel dalam
dokumen seperti kamu menggambar tabel dalam kertas menggunakan pensil
dan mistar. Perhatikan langkah-langkah berikut ini.
• Tempatkan titik sisip di posisi yang kamu inginkan.
• Pilih dan klik menu Table dan kemudian klik menu Draw Table.

• Atau klik tombol toolbar  Tables and Borders.
• Dengan tombol Toolbar Draw Table, arahkan penunjuk mouse yang

berbentuk pensil ke posisi awal dari tabel yang akan kalian buat dan
geser (drag) ke arah posisi akhir sampai diperoleh ukuran yang sesuai.

• Klik dan geser (drag) penunjuk mouse di dalam tabel untuk menggambar
garis batas kolom dan garis batas baris.

Aktivitasku

C. Membuat Tabel dengan Cara Menggambarnya
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Gambar 5. 9 Contoh penggunann toolbar Tables and Borders

Beberapa tombol toolbar Tables and Borders yang dapat kamu gunakan
adalah sebagai berikut.

Draw Table Menggambar atau membuat garis tabel

Eraser Menghapus garis tabel

Line Style Memilih jenis garis yang akan digambar

Line Weight Memilih ketebalan garis yang akan digambar

Border Color Memilih warna garis

Border Membuat garis batas atau bingkai

Shanding Color Memberi warna latar belakang

Merge Cells Menggabungkan beberapa sel yang dipilih

Split Cells Membagi sel

Ikon      Toolbar                                    Fungsi

Tabel 5. 1 Daftar toolbar Tables and Borders dan fungsinya
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Align Mengatur penempatan teks pada sel

Distribute Rows Evenly Menyamakan tinggi beberapa baris

Distribute Coumns Evenly Menyamakan lebar kolom

Table AutoFormat Memformat tabel

Change Text Direction Mengubah arah teks

Sort Ascending Mengurutkan data dengan urutan menaik

Sort Descending Mengurutkan data dengan rutan menurun

AutoSum Menjumlahkan angka secara otomatis

D. Menyunting Sel, Baris, dan Kolom

Setelah membuat tabel dan mengisinya dengan data, kamu dapat
menyunting isi dan format tampilan sesuai kebutuhan.

Gambar 5. 10 Tampilan menu Table
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Menu Insert                                    Fungsi

Jika kamu ingin menghapus suatu sel,
pilih sel yang ingin kamu hapus, kemudian
tekan Delete, tetapi jika ingin menghapus
kolom, baris: Pilih dan klik Table > Delete
> Cells maka akan muncul Delete Cells.

Dalam menu Delete Cells terdapat
beberapa perintah. Untuk mengetahui fungsi
perintah-perintah tersebut, perhatikan tabel
di bawah.

Gambar 5. 11 Tampilan menu Delete Cells

Table

Row

Column

Cell

Memilih seluruh bagian tabel tempat kursor berada

Memilih baris tempat kursor berada

Memilih kolom tempat kursor berada

Memilih sel tempat kursor berada

E. Menghapus Sel, Kolom, dan Baris

Untuk menyisipkan baris atau kolom baru, pilih dan klik menu Tables
kemudian menu Insert, pilih dan klik salah satu perintah berikut.
- Columns to the left untuk menyisipkan kolom di sisi kiri.
- Columns to the right, yaitu untuk menyisipkan kolom di sisi kanan.
- Rows Above untuk menyisipkan baris atau kolom di atas.
- Rows Bellow untuk menyisipkan baris atau kolom di bawah.

Menghapus baris

Menghapus kolom

Menu Delete Cells                                    Fungsi

Delete entire Row

Delete entire column

Shift cell left

F. Menyisipkan Baris atau Kolom Baru

Menghapus satu sel pada posisi kursor dan diisi dengan sel dikanannya

Shift cell up Menghapus satu sel pada posisi kursor dan diisi dengan sel di
bawahnya

Tabel 5. 2 Daftar menu tabel dan fungsinya

Tabel 5. 3 Daftar menu Delete Cells dan fungsinya
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Perhatikan contoh hasil penyisipan tabel menggunakan tabel Microsoft
Excel berikut.

Gambar 5. 13 Tampilan tabel menggunakan toolbar Microsoft Exel Worksheet

G. Membuat Tabel dengan Menyisipkan Microsoft Excel

Untuk membuat tabel dengan cara menyisipkam Microsoft Excel,
perhatikan langlah-langkah berikut.
• Klik ikon Microsoft Excel Spreadsheet.
• Pilihlah jumlah kolom dan baris sesuai yang kamu inginkan.

Gambar 5. 12 Tampilan toolbar Microsoft Excel Worksheet
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Rangkuman

Aktivitasku

Buatlah tabel seperti gambar di atas menggunakan Tabel Microsoft Exel Worksheet
di dalam Microsoft Word.

• Membuat tabel dalam Microsoft Word dapat dilakukan dengan menggunakan:
- Insert Table.
- Menggambar Tabel (Draw Table).
- Menyisipkan lembar kerja Microsoft Excel.

• Tampilan tabel dalam Microsoft Word dapat di format menggunakan fasilitas
AutoFormat.

• Menghapus isi dari suatu sel dapat dilakukan dengan menyorot sel tersebut
kemudian menekan Delete.

• Untuk menghapus kolom yang sedang disorot, pilih dan klik Table > Delete >
Columns.

• Untuk menghapus baris yang sedang disorot, pilih dan klik manu Table > De-
lete > Rows.

• Untuk menyesuaikan lebar kolom dengan isi sel yang paling panjang yang ada
di dalamnya, klik dua kali batas kanan kolom.

Refleksi

Ada beberapa cara untuk membuat tabel. Jika kamu ingin membuat tabel pakailah
cara yang menurut kamu paling mudah. Tetapi, jangan berpatokan dengan satu
cara saja, kamu juga harus berlatih dengan cara-cara yang lain. Dengan sering
berlatih, kamu akan makin mahir dan mendalami aplikasi-aplikasi dalam Microsoft
Word, salah satunya adalah aplikasi untuk membuat tabel.
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1.        Gambar ikon di samping bernama...
a. Toolbar Microsoft Excel Worksheet
b. Toolbar Table
c. Toolbar Insert Table
d. Toolbar AutoFormat

2. Membuat tabel dengan menggambar
menggunakan perintah...
a. Table > Select
b. Table > Insert
c. Table > Draw Table
d. Table > Cells

3.       Gambar ikon di samping berfungsi
untuk...
a. Menggambar tabel
b. Menghapus tabel
c. Menyisipkan tabel
d. Membuat garis pada tabel

4.

Perhatikan gambar di atas!
Gambar menu di atas bertujuan untuk...
a. Memformat tabel
b. Menyunting tabel
c. Menyisipkan tabel
d. Menghapus tabel

5.

Perhatikan gambar di atas!
Gambar tabel di atas menggunakan...
a. Microsoft Excel Worksheet
b. Draw Table
c. AutoFormat Table
d. Insert Table

6.  Gambar ikon di samping
dinamakan...
a. Align
b. AutoSum
c. Sort Ascending
d. Sort Descending

7. Fungsi dari gambar  ikon pada nomor 6
yaitu...
a. Menempatkan teks pada sel
b. Menjumlahkan sel di atas atau kiri

kursor
c. Mengurutkan data dengan urutan

menaik
d. Mengurutkan data dengan urutan

menurun
8. Menu Rows Above berfungsi untuk...

a. Membuat tabel
b. Menyisipkan kolom ke atas
c. Menghapus kolom atas
d. Menghapus kolom bawah

9. Menu Shift cells left pada kotak Delete
Cells berarti...
a. Menghapus sel kiri
b. Menghapus sel atas
c. Menghapus baris kolom
d. Menghapus semua kolom

Uji Kompetensi

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.
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1. Coba kamu jelaskan langkah-langkah membuat tabel!
2. Coba kamu jelaskan cara memformat tabel!
3. Coba kamu jelaskan 5 toolbar dalam Draw Table!
4. Jelaskan cara menyisipkan tabel Microsoft Excel ke dalam MS.Word!
5. Jelaskan cara menyisipkan sel baru dan kolom baru pada tabel yang sudah ada!

B. Jawablah pertanyaan-pertanyaan di bawah ini dengan benar!

10.        Ikon di samping dinamakan...

a. Border
b. Border Color
c. Table AutoFormat
d. Draw Table
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Perangkat Lunak
Microsoft Excel

Perangkat lunak pengolah angka adalah perangkat lunak yang
digunakan untuk mengelola dan menyimpan data-data, khususnya data-
data yang berupa angka. Salah satu perangkat lunak pengolah angka yang
banyak digunakan adalah Microsoft Excel. Microsoft Excel merupakan
perangkat lunak pengolah angka yang dilengkapi dengan kemampuan untuk
melakukan berbagai operasi. Nah, agar kamu mengetahui lebih detail
tentang Microsoft Excel dan dapat mengoperasikannya, ayo, pelajari bab
ini dengan baik.

Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) mengaktifkan program Microsoft Excel;
2) mengidentifikasi menu, toolbar, dan ikon Microsoft Excel;
3) mengenal fungsi menu dan submenu Microsoft Excel;
4) mengatur baris toolbar;
5) menggunakan menu, shortcut, dan toolbar.

Bab 6
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Peta Konsep

Kata Kunci

• Microsoft Excel
• Shortcut
• Formula
• Workbook

• Freeze Panes
• Office Assistant
• Split
• Help

Pengertian
Microsoft Excel

Cara Menggunakan
Mouse

Perangkat Lunak
Microsoft Excel

Mengenal Fungsi Menu
dan Submenu

Mengenal Penunjuk
Sel

Mengaktifkan
Program Excel 2003

Menggunakan dan
Mengatur Baris Toolbar

Mengidentifikasi Menu,
Toolbar dan Ikon

Microsoft Excel 2003

Menggunakan
Menu, Shortcut,

dan Toolbar

Elemen-elemen
Microoft Excel

2003
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A. Pengertian Microsoft Excel

Perangkat lunak aplikasi pengolah angka adalah perangkat lunak khusus
untuk menangani permasalahan yang berkaitan dengan angka. Dalam hal ini,
angka yang sering muncul di bidang bisnis, ilmiah, perencanaan, pembuatan
statistik, pembuatan lembar kerja, pengolahan database (basis data) dan grafik.
Software pengolah angka antara lain Lotus 123, Quattro Pro, dan Microsoft
Excel.

Microsoft Excel adalah salah satu software (piranti lunak) jenis spread-
sheet yang dibuat oleh perusahaan raksasa Microsoft, perusahaan yang juga
membuat sistem operasi Windows. Microsoft Excel dapat berdiri sendiri atau
merupakan bagian dari Microsoft Office, suatu suite programme (gabungan
beberapa program namun berfungsi sebagai satu kesatuan program/saling
terkoneksi satu sama lain). Piranti lunak (software) tipe spreadsheet mulai
dikenal ketika diperkenalkannya software VisiCalc pada suatu pameran
komputer di Amerika tahun 1979. Saat itu, VisiCalc masih diperuntukkan
untuk komputer berbasiskan Sistem Operasi UNIX. Program ini kemudian
dibeli oleh perusahaan Lotus. Akhirnya Lotus membuat software spread-
sheet sendiri yang dibuat berdasarkan pengembangan dari VisiCalc yang
diberi nama Lotus 1-2-3. Lotus 1-2-3 menjadi standard software spread-
sheet untuk beberapa waktu lamanya sebelum kemudian Microsoft
mempopulerkan produk Excel-nya dengan basis Windows (Microsoft Excel
4.0 for Windows). Semenjak itulah Microsoft Excel memimpin aplikasi soft-
ware spreadsheet.

Excel semula dikembangkan untuk PC berbasiskan Apple-MacIntosh.
Produk pertama bagi PC-IBM langsung memakai Versi 2.0, semata-mata
untuk menyeragamkan versi Excel yang sudah mencapai versi 2.0. 3 - 1990
sudah menyertakan toolbar, kemampuan menggambar, grafik 3-D (tiga
dimensi) dan beberapa tambahan fasilitas lainnya. Versi 4 -1992 adalah versi
yang terpopuler. Dalam versi 4 -1992 sudah menyertakan banyak fasilitas
tambahan lainnya. Versi Microsoft Excel for Windows dikeluarkan  5 -
1993.  Perbaikan besar-besaran, termasuk kemampuan menampilkan
beberapa lembar kerja sekaligus dalam suatu workbook.  Excel 7-1995 dikenal
juga sebagai Excel 95. Penomoran versi langsung melompat ke versi -7 tanpa
ada versi -6, semata-mata agar terdapat keseragaman versi dengan soft-
ware yang terintegrasi dalam Microsoft Office for Win’95. Versi ke-7 dari
Excel merupakan versi pertama yang memiliki kemampuan 32-bit, walau
fasilitasnya sebagian besar sama dengan versi 5 dikenal juga sebagai MS-
Excel 97. Adapun versi 9-1999  dikenal juga sebagai MS-Excel 2000  dan
sudah mengenal format bahasa HTML.  Versi 10-2001  dikenal juga sebagai
MS-Excel XP (Experience).
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Gambar 6.1 Tampilan menu Program

Ada banyak cara yang dapat digunakan untuk memulai atau membuka
program aplikasi Excel 2003.

B. Mengaktifkan Program Excel 2003

Gambar 6. 2 Tampilan lembar kerja Excel 2003

Perhatikan tampilan jendela Microsoft Excel berikut.

1. Memulai Excel 2003 dengan Menggunakan Tombol Start di
Taskbar

Untuk memulai atau membuka Excel 2003 dengan menggunakan tombol
Start yang ada di Taskbar, ikuti langkah-langkah berikut ini.
- Klik tombol Start yang ada di Taskbar.
- Pilih menu Program.
- Pilih dan klik program Microsoft Excel 2003 ditampilkan.
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2. Memulai Excel 2003 dengan Memanfaatkan Microsoft Office Short-
cut Bar

Selain dengan menggunakan cara di atas, kamu juga dapat memulai
atau  menjalankan Excel 2003 dengan memanfaatkan Microsoft Office Short-
cut Bar  yang ditampilkan pada area kerja (desktop). Untuk itu, ikuti langkah
berikut ini.
a. Nyalakan komputer, tunggu sampai komputer menampilkan area kerja

(desktop) Windows XP dan Microsoft Office Shortcut Bar.
b. Kemudian, pilih dan klik tombol toolbar Excel 2003 yang ada pada

Microsoft Office Shortcut Bar.

3. Memulai Excel 2003 dengan Memilih Menu New Office Docu-
ment

Untuk memulai atau menjalankan Excel 2003 melalui menu New Office
Document, ikuti langkah-langkah berikut ini.
1. Nyalakan komputer, tunggu sampai komputer menampilkan area kerja

(desktop) Windows XP.
2. Klik tombol Start yang ada di taskbar.
3. Pilih dan klik menu New Office Document. Kotak dialog New Office

document akan ditampilkan.
4. Pada kotak dialog tersebut, klik Tab General. Kemudian pilih dan klik

ikon Blank Workbook.
5. Klik OK. Tunggu sampai jendela kerja Excel ditampilkan.

Gambar 6. 3 Cara membuka Excel di menu New Office Document
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Menu, yaitu daftar perintah yang digunakan untuk menjalankan suatu
perintah. Baris Menu (Menu Bar) berisi barisan perintah, seperti menu File,
Edit, View, Insert, Format, Tools, Data, Windows, dan Help.

Untuk menggunakan menu dan perintah yang terdapat pada baris menu,
cukup dilakukan dengan cara memilih dan mengklik nama menu yang ada
pada baris menu, kemudian pilih dan klik perintah yang diinginkan. Beberapa
perintah yang terdapat pada baris menu mempunyai tombol shortcut untuk
menyimpan file, yaitu Ctrl + S.

Ikon atau simbol, yaitu tombol perintah yang digunakan untuk menjalankan
suatu perintah dengan cepat dan mudah, terutama perintah yang sering
digunakan.

Gambar 6. 4 Tampilan Kotak Dialog Microsoft Office

Gambar 6. 5 Tampilan Menu pada Exel 2003

C. Mengidentifikasi Menu, Toolbar, dan Ikon Excel 2003
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D. Mengenal Fungsi Menu dan Submenu

1. Menu File, Submenu File, dan Fungsinya

2. Menu Edit, Submenu Edit, dan Fungsinya

Undo Membatalkan perintah yang telah dilakukan.

Repeat atau Redo Mengulangi perintah yang telah dilakukan.

Menghapus dan memindahkan teks atau objek yang dipilih / disorot
ke Clipboard.

Copy Menyalin teks atau objek yang dipilih / disorot ke Clipboard.

Office Clipboard Membuka isi Clipboard

Submenu Edit                                                  Fungsi

Tabel 6. 1 Daftar submenu File dan fungsinya

New Membuka dokumen atau lembar kerja yang baru  yang masih kosong.

Open Membuka file atau dokumen yang telah disimpan.

Close Menutup dokumen.

Save Menyimpan dokumen ke hard disk atau disket.

Save As Menyimpan dokumen dengan nama lain atau format lain.

Submenu File                                                   Fungsi

Save as Web Page Menyimpan dalam format web page.

File Search Mencari teks tertentu dalam file di dokumen.

Permission Menentukan sifat kerahasiaan dokumen.

Web Page Preview Melihat tampilan dokumen dalam format Web Page.

Page Setup Mengatur tampilan halaman yang akan dicetak.

Print Area Memilih area pada lembar kerja yang akan dicetak.

Print Preview Melihat tampilan dari dokumen yang akan dicetak.

Print Mencetak dokumen dan mengatur printer.

Send To Mengirim dokumen melalui E-mail.

Exit Menutup program Microsoft Excel.

Tabel 6. 2 Daftar submenu Edit dan fungsinya

Cut
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3. Menu View, Submenu View, dan Fungsinya

Paste Menempatkan teks atau objek yang ada di Clipboard pada posisi
titik sisip berada

Paste Special Menempatkan teks atau objek yang ada di Clipboard pada posisi
titik sisip berada, tetapi dengan format berbeda

Paste as Hyperlink Menempatkan teks sebagai Hyperlink

Fill Menyalin isi atau format sel sesuai sel yang berada di atas (Down),
di bawah (Up), di kanan (left) atau di kiri (Right)

Clear Menghapus semua data (All), format data, (Formats), komentar
(Comments), dan isi data (Contents) yang ada di lembar kerja

Delete Menghapus sel, baris (Entiro row), atau kolom (Entiro Column)

Delete Sheet Menghapus lembar kerja (Sheet)

Move or Copy Sheet Memindahkan atau menyalin sheet pada  kerja lain

Find Mencari teks dari dokumen yang sedang aktif

Replace Mencari dan mengganti teks tertentu

Go To Menuju ke halaman Footnote, Endnote, atau bagian lain dalam
dokumen

Links Mengubah sumber link objek pada dokumen aktif

Object Mengedit objek yang bukan berasal dari dokumen Excel

Normal Melihat tampilan layar dalam bentuk normal

Page Break Preview Melihat dan mengatur pemotongan halaman pada lembar kerja

Task Pane Menampilkan atau menyembunyikan Task Pane di layar

Toolbars Menampilkan atau menyembunyikan Toolbar

Formula Bar Menampilkan baris rumus (formula bar) untuk melihat isi sel aktif
dan alamat sel aktif di lembar kerja

Status Bar Menampilkan baris status (status bar) berisi teks penjelasan
operasi yang dapat digunakan selanjutnya

Submenu View                                                Fungsi

Tabel 6. 3 Daftar submenu View dan fungsinya
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Header and Footer Membuat dan menghapus catatan atas (Header) dan catatan
bawah (Footer)

Comments Menampilkan toolbar Reviewing dan Comment pada lembar kerja

Custom Views Melihat tampilan layar sesuai keinginan

Full Screen Menampilkan dokumen pada layar monitor secara penuh

Zoom Menentukan ukuran tampilan lembar kerja pada layar

4. Menu Insert, Submenu Insert, dan Fungsinya

Cell Menyisipkan sel yang berisi data atau sel kosong

Rows Menyisipkan baris kosong

Columns Menyisipkan kolom kosong

Worksheet Menyisipkan lembar kerja (Worksheet)

Chart Menyisipkan grafik (Chart)

Symbol Menyisipkan symbol (simbol) ke dalam lembar kerja

Page Break Memotong halaman menjadi beberapa bagian

Menyisipkan fungsi logika, basis data, statistika, matematika,
trigonometri, keuangan, dan lain-lain

Menyisipkan nama range data, menampilkan nama range, dan
membuat range untuk label lembar kerja

Comment Menyisipkan komentar ke lembar kerja

Menyisipkan gambar atau objek dari file, ClipArt, scanner, atau
kamera ke dalam lembar kerja aktif

Diagram Menyisipkan diagram

Menyisipkan objek dari program aplikasi lain ke dalam lembar kerja
Excel

Hyperlink Menyisipkan link berupa teks, file, atau dokumen Web Page

Submenu Insert                                               Fungsi

5. Menu Format, Submenu Format, dan Fungsinya

Menentukan format sel yang akan dibuat,  contohnya angka dan
huruf

Submenu Format                                  Fungsi

Tabel 6. 4 Daftar submenu Insert dan fungsinya

Tabel 6. 5 Daftar submenu Format dan fungsinya

Function

Name

Picture

Object

Cells
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6. Menu Tools, Submenu Tools, dan Fungsinya

Mengatur tinggi sel dan menyembunyikan atau menampilkan
baris

Mengatur lebar sel dan menyembunyikan atau menampilkan
kolom

Sheet Memformat Sheet yang sedang aktif

Menggunakan fasilitas format otomatis yang disediakan Excel
untuk memformat tabel

Conditional Formatting Memformat data dalam sel tertentu disorot pada lembar kerja

Style Memformat dan mengubah data pada lembar kerja

Tabel 6. 6 Daftar submenu Tools dan fungsinya

Spelling Memeriksa ejaan dan tata bahasa dari teks atau angka,nilai,
Header, dan Footer

Research Menjalankan fasilitas pencarian arti kata dan alih  bahasa

Error Checking Memeriksa kesalahan penulisan rumus

Mengubah pembicaraan melalui mikrofon menjadi teks atau
sebaliknya

Memindahkan ke Modus Shared Workspace (lembar kerja
yang disembunyikan) yang memungkinkan pengguna lain
dalam jaringan komputer untuk mengubah atau menyimpan
Workspace yang sama

Memindahkan ke Modus Shared workbook (buku kerja yang
disembunyikan) yang memungkinkan pengguna lain dalam
jaringan komputer untuk mengubah atau menyimpan Work-
book yang sama

Track Changes Menandai sel yang baru diubah isinya
Compare Merge
Workbooks

Memproteksi Sheet, Workbook, dan Share Workbook
menggunakan password (kata sandi)

Online Collaboration Mengadakan diskusi dan bertukar informasi melalui internet

Mengubah nilai pada sel berdasarkan rumus yang ditetapkan
sehingga hasilnya sesuai keinginan

Submenu Tools                                   Fungsi

Membandingkan dan menggabungkan worksheet

Row

Column

AutoFormat

Shared Workspace

Share Workbook

Speech

Protection

Goal Seek



Perangkat Lunak Microsoft Excel 93

7. Menu Data, Submenu Data, dan Fungsinya

Membuat, menampilkan, menghapus, mengedit scenario, dan
membuat ringkasan  laporan scenario pada lembar kerja Ex-
cel

Meletakkan rumus yang menggunakan nilai pada sel aktif,
mengatur sel yang meletakkan data ke rumus, dan
menyembunyikan nilai yang salah pada sel

Macro Membuat dan menghapus macro sendiri

Mengaktifkan atau menonaktifkan program Add-Ins milik
Excel

Auto Correct Options Memperbaiki teks secara otomatis

Menata toolbar, menambahkan perintah baru, membuat menu
dan toolbar sesuai dengan keinginan

Membantu menggunakan delapan tabulasi, yaitu View, Cal-
culation, Edit, General, Transition, Color,  Custom Lists, Chart

Sort Mengurutkan data atau teks sesuai alfabet

Filter Mengurutkan dan mengelola daftar data

Membuat atau menambah record (rekaman), record,
dan menampilkan kriteria

Subtotals Menghitung nilai subtotal dan total akhir

Validations Membatasi jenis data yang dapat kita masukkan

Membuat satu atau lebih variabel data dan menambah
rumus

Mengubah data berbentuk teks menjadi kolom pada
lembar kerja

Menyesuaikan data berdasarkan pada posisi, kategori,
menambah daerah sumber data lain

Menggabungkan (group) dan membingkai data pada
lembar kerja seperti objek, numerik, dan lain-lain

PivotTable and PivotChart
Report

Import External Data Mengambil data dari Excel ke luar Excel

List Menampilkan keterangan data

Submenu Data                                Fungsi

Tabel 6. 7 Daftar submenu Data dan fungsinya

Membuat tabel pivot dan grafik pivot di lembar kerja

Scenarios

Formula Auditing

Add-Ins

Customize

Options

Form

Table

Text to Columns

Consolidate

Group and Outline
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9. Menu Help, Submenu Help, dan Fungsinya

Microsoft Excel Help Menampilkan menu Help Excel

Show the Office Assistant Menyembunyikan atau menampilkan Office Assistant

Menampilkan berbagai informasi terakhir
mengenaiprogram apli-kasi Microsoft Office
melalui internet

Contact Us Menampilkan layanan penggu-naan dari vendor

Memeriksa dan memperbarui program Excel melalui
internet

Detect and Repair Mendeteksi dan memperbaiki program Excel

Activate Product Mendeteksi aktivitas Excel

Submenu Help                                 Fungsi

8. Menu Window, Submenu Window, dan Fungsinya

Menampilkan lembar kerja yang sama pada jendela
berbeda

Mengatur letak dan bentuk jendela kerja  yang aktif agar
dapat melihat seluruh lembar kerja yang aktif dengan
ukuran sama dalam waktu bersamaan

Compare Side by Side with Menampilkan dua lembar kerja sekaligus

Hide Menyembunyikan lembar kerja aktif

Unhide Menampilkan kembali lembar kerja yang disembunyikan

Membagi jendela kerja pada dokumen aktif menjadi dua
bagian agar dapat melihat bagian berbeda dari dokumen
yang sama pada waktu bersamaan

Menahan tampilan sebagian lembar kerja agar tetap
dapat melihat sel yang ada dibagian lain lembar kerja

Submenu Window                                               Fungsi

XML Mengambil data XML

Menyegarkan kembali data yang diperoleh dari  data luar
(external) dan tabel pivot

Tabel 6. 8 Daftar submenu Window dan fungsinya

Tabel 6. 9 Daftar submenu Help dan fungsinya

Refresh Data

New Window

Arrange

Split

Freeze Panes

Microsoft Office Online

Check for Updates
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10. Menu Utama pada Excel adalah Main Menu Bar

Main Menu Bar ini merupakan menu utama pada Excel. Walaupun
beberapa fitur menu pada Excel sudah ditampilkan dalam bentuk-bentuk ikon-
ikon pada standart toolbar maupun pada formatting toolbar.

Gambar 6. 6 Tampilan Main Menu Bar

11. Formula Bar adalah Inti dari Excel

Untuk mengaplikasikan sebuah formula rumus pada Excel, Kamu harus
mengetikkannya pada formula bar. Pengisian rumus diawali dengan tanda
sama dengan “=”. Jika tidak diawali dengan tanda “=” maka formula rumus
yang dimasukkan akan dianggap teks biasa.

Gambar 6. 7 Tampilan Formula Bar

12. Baris, Kolom, dan Sel
Baris (row) adalah sebuah deretan menurun yang dilambangkan dengan

deretan angka terkecil hingga terbesar. Contoh nama baris adalah baris 1, 2,
3, 4, dan seterusnya.

Kolom (column) adalah sebuah deretan memanjang yang dilambangkan
dengan karakter alfabet A sampai Z. Contoh kolom adalah kolom A, B, C, D,
dan seterusnya.

Gambar 6. 8 Baris
(Row)

Sel (cell) adalah persinggungan antara kolom dengan baris. Contohnya
sel A1, A2, B2, B3 dan seterusnya.

Gambar 6. 10 Tampilan Sel

Gambar 6. 9 Tampilan Kolom

Customer Feedback Options Menampilkan layanan konsumen

About Microsoft Excel Menunjukkan versi Microsoft Excel yang digunakan
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Gambar6. 15 Tampilan Menu view

13. Worksheet dan File

File Excel bisa diumpamakan seperti sebuah rumah, dan worksheet
adalah kamar-kamarnya. Dalam satu file Excel kita bisa memiliki banyak
worksheet.

Gambar 6. 11 Tampilan Worksheet

Excel 2003 pada keadaan defaultnya akan menampilkan tiga baris toolbar,
yaitu: Toolbar Standar, Toolbar Formating, dan Toolbar Drawing.

Gambar 6. 12 Toolbar Standar

Gambar 6. 13 Toolbar Formating

Gambar 6. 14 Toolbar Drawing

Tombol toolbar tersedia dengan mengklik tombol
panah Drop down toolbar options yang terletak di ujung
kanan baris toolbar. Apabila diperlukan, kamu dapat
memilih tampilan baris toolbar lain, dengan menggunakan
langkah berikut.
- Pilih dan klik menu View.
- Pilih dan klik Toolbars > Customize.

Jika ingin menampilkan baris toolbar lain, yaitu dengan
cara mengklik tombol mouse sebelah kanan pada baris
toolbar yang terlihat. Kemudian pada menu shortcut yang
ditampilkan, pilih dan klik baris toolbar yang diinginkan.

Adapun jika ingin menambah atau mengurangi
kelengkapan baris toolbar yang ada, pilih dan klik tombol
toolbar Add or Remove Buttons. Kemudian, berilah tanda
centang pada toolbar yang ingin ditampilkan.

E. Menggunakan dan Mengatur Baris Toolbar
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Gambar 6. 17 Tampilan Lembar kerja Exel 2003

Gambar 6. 16 Tampilan Menu Tools dan kotak dialog Cuztomize

Agar toolbar terlihat rapi pada layar, ikuti langkah-langkah berikut.
1. Klik bagian ujung panah    di sebelah kanan atas layar seperti pada

gambar di bawah.
2. Dua pilihan akan muncul. Pilihlah Show Buttons on Two Rows dengan

mengkliknya.

Tanda panah

Menu Show Buttons on
Two Rows



Teknologi Informasi dan Komunikasi VIII SMP98

Gambar 6. 18 Tampilan Toolbar pada lembar kerja Exel

F. Mengenal Elemen-Elemen Toolbar dan Fungsinya
1. Tombol Toolbar Standard

Hasilnya akan terlihat seperti berikut ini. Toolbar bertambah satu baris
menjadi dua baris.

New Blank  Document

Open

Save

E-mail

Print

Print Preview

Spelling and Grammar

Research

Cut

Copy

Paste

Format Painter

Ikon Perintah Fungsi

Membuat dokumen baru yang masih kosong

Membuka berkas dokumen yang telah kita simpan

Menyimpan dokumen ke hard disk, disket, flash disk
USB, atau media lain

Menulis /mengirim e-mail

Mencetak dokumen ke printer dengan menggunakan
pilihan default

Beralih ke tampilan cetak

Memeriksa ejaan

Mencari hal-hal yang berkaitan dengan Excel

Menyalin teks kita pilih (sorot) ke Clipboard

Memindahkan teks kita pilih (sorot) ke Clipboard

Mengambil teks yang ada di Clipboard

Menyalin format teks yang kita pilih (sorot) ke Clip-
board

Tabel 6. 10 Daftar ikon Toolbar Standard dan fungsinya

Undo Membatalkan perintah
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Redo

Insert Hyperlink

AutoSum

Short Ascending

Short Descending

Chart Wizard

Drawing

Zoom

Microsoft Office
Excel Help

Membatalkan proses Undo

Menyisipkan Hyperlink

2. Tombol Toolbar Formatting

Menjumlah secara otomatis dengan fasilitas Excel

Mengurutkan data secara menaik

Mengurutkan data secara menurun

Membuat dan menempatkan grafik

Menampilkan toolbar drawing

Mengatur tampilan layar

Meminta bantuan yang diperlukan jika terjadi
kesulitan mengenai Excel

Font

Font Size

Bold

Italic

Underline

Align Left

Center

Align Right

Ikon Perintah Fungsi

Mengubah jenis dan bentuk huruf (font)

Mengubah ukuran huruf (font size)

Menampilkan huruf tebal (bold)

Menampilkan huruf miring (italic)

memberi garis bawah (underline)

Menampilkan paragraf dengan posisi rata kiri

Menampilkan paragraf dengan posisi di tengah

Menampilkan paragraf dengan posisi rata kanan

Tabel 6. 11 Daftar ikon Toolbar Formating dan fungsinya
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Justify

Merge and Center

Currency Style

Percent Style

Comma Style

Increase decimal

Decrease decimal

Decrease Indent

Increase Indent

Borders

Fill Color

Font Color

Menampilkan paragraf dengan posisi rata kiri dan
kanan

Menggabung dan mengetengahkan sel

Memformat angka dalam mata uang tertentu

Memformat angka menjadi bentuk persen

Memformat angka menjadi angka dengan format
pemisah ribuan dan angka desimal

Menambah format angka desimal

Mengurangi format angka desimal

Memajukan paragraf satu langkah

Memundurkan paragraf satu langkah

Menambahkan garis batas (border)

Memberikan warna latar huruf

Memberi dan memilih warna huruf (font color)

 3. Menggunakan Tombol Toolbar Drawing

Font Color

Line Style

Dash Style

Arrow Style

Shadow Style

Ikon Perintah Fungsi

Mengatur warna

Mengatur ketebalan dan tipe garis

Mengatur bentuk dan arah tanda panah

Mengatur model tampilan garis

Memberikan efek bayangan (shadow) pada objek
yang kita pilih

Memberikan efek 3 dimensi pada objek yang kita
pilih

Tabel 6. 12 Daftar ikon Toolbar Drawing dan fungsinya

3-D Style
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G. Elemen Excel 2003

Gambar 6. 19 Lembar kerja Excel 2003

Lines

Arrow

Rectangle

Oval

Text Box

Fill Color

Line Color

Membuat garis

Membuat garis berujung panah

Membuat bingkai berbentuk segi empat

Membuat bingkai berbentuk lingkaran atau oval

Menempatkan kotak berisi teks

Mengatur warna isi bingkai atau kotak teks

Mengatur warna garis atau bingkai

Mengatur objek hasil pembuatan

Menampilkan menu AutoShapes

Memilih objek

Mengatur objek gambar yang sudah kita tempatkan

Draw

AutoShapes

Select Object

Free Rotate

Perhatikan gambar di bawah ini.

Baris Judul
Baris Menu Baris Toolbar Tombol Ukuran

Toolbar
Standard
Toolbar
Formatting

Baris (Row)

Tab lembar kerja Baris penggulung mendatar

Baris penggulung tegak

Penunjuk sel

Baris rumus

Kolom

Task
Panel
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Untuk bekerja dengan Excel, kamu harus menggunakan kombinasi key-
board dan mouse.

H. Cara Menggunakan Mouse

1. Ikon kontrol menu (Control Menu Icon) digunakan untuk mengontrol
jendela yang sedang aktif.

2. Baris Judul (Title Bar) berisi nama program aplikasi dan nama file yang
sedang aktif. Baris judul ini dapat juga digunakan untuk memindahkan
jendela ke posisi lain yang kita inginkan.

3. Baris menu (Menu Bar) berisi barisan perintah seperti menu File, Edit,
View, Insert, Format, Tools, Data, Windows, dan Help.

4. Tombol ukuran (Sizing Button) berguna untuk memperbesar atau
memperkecil jendela Excel, mengembalikan jendela ke ukuran semula
atau sebelumnya, dan menutup atau mengakhiri Excel. Tombol ukuran
terdiri atas tombol minimize untuk memperkecil jendela hingga
membentuk ikon aktif pada taskbar, tombol maximize untuk
memperbesar jendela hingga menjadi satu layar penuh, dan tombol close
untuk menutup jendela dan mengakhiri program aplikasi.

5. Baris toolbar (Toolbars) berisi tombol-tombol yang digunakan untuk
menjalankan suatu perintah dengan cepat dan mudah, terutama untuk
perintah-perintah yang sering digunakan. Contoh toolbar, yaitu toolbar
standard, formatting, dan drawing.

6. Baris penggulung (Scroll Bar) untuk menggeser layar. Baris penggulung
mendatar (horizontal scroll bar) digunakan untuk menggeser layar ke
kiri   atau ke kanan, sedangkan baris penggulung tegak (vertical scroll
bar) digunakan untuk menggeser layar ke atas atau ke bawah.

7. Baris Rumus (Formula Bar) menampilkan informasi mengenai isi sel
yang sedang aktif (disorot) di lembar kerja.

8. Kotak indikator untuk menampilkan nama sel yang aktif.
9. Microsoft Office Assistant menampilkan gambar animasi yang banyak

membantu kamu pada saat bekerja dengan Excel 2003. Contohnya, Clippit
yang berbentuk klip kertas atau Links yang berbentuk kucing. Microsoft
Excel 2003 menampilkan Task Pane berupa kotak Microsoft Office
Online dan kotak Open pada opsi Getting Started. Jika tanda segitiga
diklik, muncul beberapa opsi lain, seperti Excel Help yang menampilkan
kotak pencari jawaban.

Keterangan gambar

10. Lembar kerja Excel 2003 terdiri atas 256 kolom (columns) dan 65536
baris (rows). Kolom pada Excel 2003 diwakili oleh  huruf A, B, C, ...,
Sampai IV, sedangkan baris diwakili oleh angka 1, 2, 3,... Sampai 65536.

11. Sel (Cell), yaitu perpotongan antara baris dan kolom. Sel diberi  nama
menurut posisi kolom dan baris pada lokasinya. Contohnya, sel C8 adalah
perpotongan antara kolom C dan baris 8.
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Apabila kamu ingin menggunakan mouse untuk memindahkan penunjuk
sel cukup dengan mengklik alamat sel yang diinginkan. Apabila alamat sel
yang akan digunakan tidak terlihat di layar, kita dapat menggulung lembar
kerja tersebut baik pada arah kiri maupun atas-bawah dengan menggunakan
baris penggulung (ScrollBar). Berikut ini adalah tombol dan keterangan yang
biasa digunakan dalam Microsoft Excel.

Tombol mouse sebelah kiri biasa dipakai untuk pemilihan dan tombol
mouse sebelah kanan dipakai untuk menampilkan menu shortcut.

I. Mengenal Petunjuk Sel (Pointer)

Istilah Keterangan

Pilih (point)

Klik (click)

Klik kanan (right-click)

Klik dua kali (double click)

Geser (drag)

Memindahkan penunjuk mouse (mouse)pada posisi atau
bagian tertentu yang diinginkan.

Menekan tombol kiri mouse satu kali.

Menekan tombol kanan mouse satu kali.

Menekan tombol kiri mouse dua kali  berurutan secara cepat
tanpa menggeser mouse.
Tekan tombol mouse (jangan dilepas) sekaligus mengge-
rakkan mouse ke posisi yang diinginkan.

Tabel 6. 12 Daftar istilah Mouse dan fungsinya

Tombol                            Keterangan

Pindah satu sel ke kiri, kanan, atas atau bawah

Pindah satu sel kanan

Pindah satu sel ke bawah

, , ,

Tab

Enter

Home

Pindah satu sel ke kiri

Pindah satu sel ke atas

Shift + Tab

Shift + Enter

Pindah ke kolom A pada posisi baris yang sedang dipilih

Tabel 6. 14 Daftar tombol Keyboard dan fungsinya
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Cara menggunakan baris menu (Menu Bar) adalah sebagai berikut.
1. Sorotlah sel atau range yang akan diformat angkanya.
2. Pilih dan klik menu Format, Cells menggunakan mouse atau

menggunakan keyboard Ctrl + 1. Kotak dialog Format Cells akan
ditampilkan.

3. Pada kotak dialog tersebut, klik Tab Border.
4. Pilih sesuai format yang diinginkan.
5. Klik OK.

J. Menggunakan Menu, Shortcut, dan Toolbar

Gambar 6. 21 Cara menggunakan Menu Bar

Pindah ke sel A1 pada lembar kerja yang aktif

Pindah ke posisi sel terakhir yang sedang digunakan

Pindah satu layar ke atas

Pindah satu layar ke bawah

Pindah satu layar ke kiri

Pindah satu layar ke kanan

Pindah dari satu tab lembar kerja ke tab lembar kerja berikutnya

Pindah dari satu tab lembar kerja ke tab lembar kerja  sebelumnya

Pindah ke akhir kolom

Ctrl + Home

Ctrl + End

PgUp

PgDn

Alt + PgUp

Alt + PgDn

Ctrl + PgUp

Ctrl + PgDn

Ctrl + ←
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Adapun cara menggunakan toolbar adalah sebagai berikut.
1. Sorotlah sel atau range yang akan diformat.

2. Pilih dan klik toolbar     Border.
3. Pilih sesuai format yang diinginkan.
4. Klik untuk mengakhiri pilihan.

Gambar 6. 22 Cara menggunakan Toolbar

Rangkuman

• Perangkat lunak aplikasi pengolah angka adalah software (perangkat lunak)
khusus untuk menangani permasalahan yang berkaitan dengan angka.

• Microsoft Excel adalah salah satu piranti lunak jenis spreadsheet yang dibuat
oleh perusahaan raksasa Microsoft, perusahaan yang juga membuat sistem operasi
Windows.

• Ada banyak cara yang dapat digunakan untuk memulai atau membuka program
aplikasi Excel 2003, yaitu sebagai berikut.
-  Memulai Excel dengan menggunakan tombol Start di Taksbar
-  Memulai Excel dengan memanfaatkan Microsoft Office Shortcut Bar
-  Memulai Excel dengan memilih menu New Microsoft Office Document

• Main Menu Bar merupakan menu utama pada Excel.
• Baris (Row) adalah sebuah deretan menurun yang dilambangkan dengan deretan

angka terkecil hingga terbesar.
• Tombol mouse sebelah kiri biasa dipakai untuk pemilihan dan tombol mouse

sebelah kanan dipakai untuk menampilkan menu shortcut.

Refleksi

Microsoft Excel adalah salah satu program pengolah angka. Di dalam Microsoft Ex-
cel, banyak menu-menu dan ikon untuk menjalankan berbagai perintah. Untuk
menjalankan Microsoft Excel, kamu harus mengenal menu-menu dan ikonnya. Agar
lebih mengenal dengan menu-menu Microsoft Excel, kamu harus sering berlatih dan
mencoba.
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1. Excel yang semula dikembangkan
PC berbasis...
a. Macintosh
b. VisiCalc
c. Apple-Macintosh
d. MS-Excel

2.

Perhatikan gambar di atas
Gambar di atas merupakan.....
a. Kotak Daftar Pilihan Microsoft

office
b. Kotak Dialog Microsoft Office
c. Kotak Daftar Pilihan New

Office Document
d. Kotak Dialog New Office

Document

Uji Kompetensi

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

3. 1. Insert 3. Toolbar
2. Format 4. Italic

      Yang termasuk baris menu adalah...
a. 1, 2 c. 2, 3
b. 1, 3 d. 3, 4

4. Sebuah deretan memanjang yang
dilambangkan dengan karakter alfabet A
sampai Z disebut...
a. Icon c. Baris
b. Menu d. Kolom

5.

Gambar di atas merupakan tampilan
Menu......
a. Menu Tools
b. Menu Format
c. Menu Data
d. Menu Window

B. Jawablah pertanyaan-pertanyaan di bawah ini dengan benar!
1. Jelaskan langkah-langkah mengaktifkan Microsoft Excel!
2. Apa saja menu-menu dalam lembar kerja Microsoft Ecel beserta fungsinya!
3. Ikon apa saja yang terdapat dalam Toolbar Standart beserta fungsinya!
4. Jelaskan langkah-langkah menggunakan baris menu!
5. Jelaskan elemen-elemen yang terdapat dalam kotak dialog!
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Teknik Dasar
Microsoft Excel

Dokumen yang kamu buat dalam lembar kerja Microsoft Excel dapat
berupa data statistik, grafik, dan lain sebagainya. Dokumen-dokumen yang
kamu buat mungkin belum sepenuhnya sempurna, untuk itu kamu perlu
mengeditnya. Nah, dalam bab ini kamu akan belajar teknik-teknik dasar
Microsoft Excel. Selain itu, kamu juga akan belajar cara mengedit dokumen
yang kamu buat. Ayo, pelajari bab ini dengan baik.

Bab 7
Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) menyorot atau memblok Range;
2) memasukkan data, mengedit, dan menghapus data;
3) menyisipkan sel, baris, dan kolom baru;
4) mengatur format sel.
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Peta Konsep

Kata Kunci

• Cells
• Insert
• Align
• Orientation

• Protection
• Pasword
• Autofill
• Accounting

Menyorot atau
Memblok Range

Memberi Proteksi
pada Lembar Kerja

Teknik Dasar Microsoft Excel

Menyisipkan Sel, Baris
dan Kolom Baru

Mengatur Format Sel

Memasukkan Data,
Mengedit, dan

Menghapus Data

Memasukkan Rangkaian
Data

Mengatur Baris

Memformat Angka
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A. Menyorot atau Memblok Range ( Sel )

Langkah-langkah yang dapat kamu lakukan untuk menyorot atau
memblok menggunakan tombol Shift adalah sebagai berikut.
• Tempatkan penunjuk sel di posisi awal, yaitu A1.
• Tekan tombol Shift kemudian tekan tombol anak panah di keyboard ke

arah yang diinginkan.
Adapun jika kamu ingin menyorot atau memblok dengan menggunakan

mouse langkah-langkahnya adalah sebagai berikut.
•  Klik sel awal (penunjuk mouse harus berupa tanda plus putih).
•  Klik tombol mouse sambil drag (geser) ke arah yang diinginkan.

Menyorot atau Memblok Kolom atau Baris

Gambar di bawah merupakan cara menyorot baris. Jika kamu mengklik
angka pada bagian kotak angka 1 maka seluruh sel pada baris angka 1 akan
terblok.

Untuk memblok secara cepat tanpa harus menggeser hingga ke bawah,
kamu cukup mengklik kotak huruf yang terdapat pada bagian atas lembar
kerja maka secara otomatis kolom tersebut akan terblok.

Gambar 7. 1 Tampilan menyorot atau memblok baris
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Gambar  7. 3 Tampilan menyorot atau memblok sel

Gambar 7. 2 Tampilan menyorot atau memblok kolom

Perhatikan tampilan sel yang disorot berikut.
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1. Memasukkan Data

Gambar 7. 4 Tampilan sel yang terdapat data

2. Mengedit Data

Untuk mengedit data, kamu harus mengklik sel yang ingin kamu edit,
kemudian ubah data kamu dalam kotak formula bar.

B. Memasukkan, Mengedit, dan Menghapus Data

3. Menghapus Data

Untuk menghapus data,
kamu dapat melakukan hal-hal
berikut ini.
• Sorot atau blok semua sel

yang ingin dihapus.
• Kemudian klik kanan

maka akan muncul kotak
menu seperti  gambar di
samping.

• Pilih dan klik menu De-
lete.

Gambar 7. 5 Tampilan menu Delete

Memasukkan data di sel lembaran kerja dilakukan dengan mengaktifkan
sel di lembaran kerja yang bersangkutan, kemudian mengetik data yang akan
dimasukkan dan diakhiri dengan menekan tombol tab atau Enter. tombol Tab
akan memindahkan sel yang aktif ke kolom berikutnya pada baris yang sama,
sedangkan tombol Enter akan mengaktifkan sel di baris berikutnya pada
kolom yang sama.
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Gambar 7. 7 Tampilan lebar kolom yang sudah diubah

C. Mengatur Lebar Kolom dan Tinggi Baris

Untuk mengatur lebar kolom dan tinggi baris, coba kamu perhatikan
langkah-langkah berikut ini.
• Pilih kolom yang ingin diubah lebarnya.
• Pilih dan klik menu Format.
• Pilih menu column.
• Pilih dan klik menu widht.
• Isi lebar kolom sesuai kebutuhan.

Gambar 7. 6 Tampilan menu Format
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Selain cara di atas, kamu juga dapat mengubah lebar kolom dengan
menggunakan mouse. Caranya, yaitu arahkan penunjuk mouse ke batas kanan
huruf kolom yang ingin di ubah lebarnya.

Gambar 7. 8 Tampilan hasil perubahan mouse menggunakan mouse

Adapun untuk mengubah tinggi baris, langkah-langkah yang dapat kamu
lakukan, yaitu sebagai berikut.
• Pilih sel yang ingin diubah.
• Pilih dan klik menu Format.
• Pilih menu Row.
• Pilih dan klik menu Height.
• Isi lebar baris sesuai kebutuhan.

Gambar 7. 10 Tampilan
kotak dialog Height

Gambar 7. 9 Tampilan menu Format
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Aktivitasku

Gambar 7. 11 Tampilan sel yang sudah diubah tingginya

Coba kamu lakukan hal-hal berikut.
• Salinlah kata-kata pada gambar di atas.
• Kemudian aturlah lebar dan tinggi sel agar terlihat rapi.
• Kemudian simpan lembar kerja kamu dalam folder masing-masing.
• Hapuslah data pada Bahasa Indonesia.
• Sesuaikanlah arti yang sebenarnya dari data Bahasa Inggris ke dalam Bahasa

Indonesia.
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D. Menyisipkan Sel, Baris, dan Kolom Baru

1. Menyisipkan Sel Baru

Untuk menyisipkan sel baru, kamu harus memperhatikan langkah-
langkah berikut ini.
• Sorot atau blok sel yang ingin kamu sisipkan.
• Kemudian klik kanan.
• Pilih dan klik menu Insert.
• Kemudian akan muncul kotak dialog seperti gambar di bawah ini.

Gambar 7. 12 Tampilan menyisipkan sel baru

Gambar 7. 13 Tampilan kotak dialog Insert

• Shift cells right digunakan untuk
memindahkan seluruh data dari sel yang
dipilih ke sebelah kanan kemudian
menyisipkannya pada sel yang masih
kosong.

• Shift cells down digunakan untuk
memindahkan seluruh data dari sel yang
dipilih ke sebelah bawah kemudian
menyisipkannya sel yang masih kosong.

Setelah kamu klik Insert maka akan muncul kotak dialog Insert, seperti
gambar di bawah. Ada beberapa pilihan untuk menyisipkan sel baru, yaitu
sebagai berikut.
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Gambar 7. 14 Tampilan hasil penyisipan sel baru

2. Menyisipkan Baris Baru

Untuk menyisipkan baris baru, kamu dapat memperhatikan langkah-
langkah berikut ini.
• Klik baris yang ingin kamu tambahkan.
• Kemudian klik kanan.
• Pilih dan klik menu Insert.

Gambar 7. 15 Tampilan menu Insert
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Gambar 7. 16 Tampilan  hasil penyisipan baris

3. Menyisipkan Kolom Baru

Untuk menyisipkan kolom baru, perhatikan langkah-langkah berikut ini.
• Klik bagian kolom yang ingin disisipkan.
• Kemudian klik kanan.
• Pilih dan klik menu Insert.

Gambar 7. 17 Tampilan menu Insert
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Aktivitasku

Coba kamu lakukan hal-hal berikut.
- Salinlah data di atas.
- Kemudian sisipkan kolom di sebelah kiri kolom A.
- Setelah itu masukan data nomor pada bagian tersebut.

Gambar 7. 18 Tampilan hasil penyisipan kolom
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Dalam Excel 2003 terdapat fasilitas AutoFill sehingga dapat memasukkan
data dengan mudah dan cepat. Untuk memasukkan rangkaian data, ikutilah
langkah-langkah berikut ini.
• Pilih atau klik sel tempat posisi awal kemudian ketik angka 1, kemudian

ketik angka 2.
• Sorot sel yang berisi 1 dan 2.
• Tempatkan pointer pada pojok kanan bawah sel hingga muncul tanda +.
• Drag tanda tersebut ke bawah sesuai kebutuhan.

Gambar 7. 19 Tampilan Fill Handle

E. Memasukan Rangkaian Data

Aktivitasku
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1. Memformat Angka Menggunakan Menu Comma

Menu Comma berfungsi untuk memberikan tanda titik (.) Untuk
memisahkan angka dengan kelipatan ribuan.

Untuk menjalankan menu Comma, perhatikan langkah-langkah berikut.
• Sorot sel yang akan diubah.
• Klik menu Comma.

Gambar 7. 20 Tampilan data yang belum di ubah

F. Memformat Angka

Coba kamu lakukan-hal-hal berikut.
- Bukalah lembar kerja Excel yang masih kosong
- Buatlah data seperti di atas
- Gunakan AutoFill untuk: a. nomor   b. hari
- Isilah tabel dengan mata pelajaran kamu

Setelah menu Comma kamu klik, secara otomatis sel yang kamu sorot
akan berubah. Perhatikan tampilan sel yang sudah diatur dengan menu Comma
berikut.
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Gambar 7. 21 Tampilan Data yang sudah diformat dengan Comma

2. Format Accounting

Untuk melakukan Format Accounting, perhatikan langkah-langkah
berikut.
• Blok sel yang ingin kamu sisipkan menggunakan Format Accounting.
• Kemudian klik kanan.
• Pilih dan klik menu Format Cells.

Gambar 7. 22 Tampilan data yang belum diformat Accounting
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Gambar 7. 24 Tampilan data yang sudah diformat Accounting

Gambar 7. 23 Tampilan kotak dialog Format Cells
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1. Mengatur Isi Sel dengan Format Alignment
Format Alignment berfungsi untuk membuat sel tampak lebih rapi.

Berikut adalah langkah-langkah membuat sel dengan Format Alignment.
• Blok semua sel yang ingin diubah.
• Klik ikon Center, atau ikon Align right, atau Align Left.

Gambar 7. 25 Tampilan data menggunakan Format Alignment

Gambar 7. 26 Tampilan data menggunakan Format Alignment Right

G. Mengatur Format Sel
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2. Menggunakan Format Merge Cell

Format Merge Cell berfungsi untuk menyatukan beberapa sel menjadi
satu sel. Untuk menggunakan format ini, perhatikan langkah-langkah berikut.
• Blok beberapa sel yang ingin dijadikan satu sel.
• Klik ikon  Merge and Center.

Gambar 7. 27 Tampilan data yang diformat menggunakan Marge Cell

3. Mengatur Perataan Teks

Untuk mengatur perataan teks, perhatikan langkah-langkah berikut.
• Blok sel data yang ingin diformat.
• Kemudian klik kanan maka akan tampil menu seperti dalam gambar di

bawah.
• Pilih dan klik menu Format Cells.
• Kemudian akan muncul kotak dialog Format Cells.

Gambar 7. 29 Tampilan
Kotak dialog Format Cells

Gambar 7. 28 Tampilan Format cell
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Gambar 7. 30 Tampilan data  meggunakan Format Cells

4. Mengubah Kemiringan Teks Hingga 90 Derajat
Untuk mengubah kemiringan teks, perhatikan langkah-langkah berikut.

• Blok sel data yang ingin diubah kemiringannya.
• Sama seperti sebelumnya klik kanan pada mouse.
• Pilih dan klik menu Format Cells.

Gambar 7. 31 Tampilan menu Format Cells
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Aktivitasku

Gambar 7. 33 Tampilan data yang sudah di Format Orientation

• Bukalah lembar kerja kosong Excel.
• Masukan data seperti gambar di bawah.

Gambar 7. 32 Tampilan kotak dialog Format Cells
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5. Menggunakan Format Wrap Text

Gambar 7. 34 Tampilan data sebelum diformat Warp Text

Jika kamu ingin menggunakan Format Wrap Text, perhatikan langkah-
langkah berikut ini.
• Blok sel yang ingin diformat dengan Wrap Teks.
• Klik kanan pada mouse.
• Pilih dan klik menu Format Cells.
• Kemudian pada kotak dialog di bagian Text Control pilih Wrap Text.
• Klik OK.

• Format data tersebut dengan menggunakan:
- Format Merge and Center.
- Format Alignment.
- Format Orientation.
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Gambar 7. 35 Tampilan kotak dialog Format Cells

Gambar 7. 36 Tampilan hasil text menggunakan Wrap Text

6. Membuat Bingkai atau Garis Pembatas

Untuk memberi bingkai atau garis pembatas pada file yang kamu buat
dalam Excel, perhatikan langkah-langkahnya berikut ini.
• Blok sel yang ingin diberi bingkai atau garis pembatas.
• Klik menu Format kemudian menu Cells.
• Kemudian akan tampil kotak dialog Format Cells.
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Gambar 7. 37 Tampilan menu Format

Gambar 7. 38 Tampilan kotak
dialog Format cells

Gambar 7. 39 Tampilan tabel menggunakan Excel

Setelah melakukan langkah-langkah tersebut, kemudian secara otomatis
muncul bingkai pada tabel. Perhatikan gambar tabel yang diberi bingkai
berikut.
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Aktivitasku

B. Coba lakukan hal-hal berikut.
• Bukalah lembar kerja baru Microsoft Excel.
• Masukkan data-data berikut ke dalam lembar kerjamu.
• Buatlah bingkai pada lembar kerjamu.

No Nama Alamat

1. Ali Brebes
2. Ivan Jakarta
3 Tata Cirebon
4. Suryo Solo
5. Budi Solo
6. Janta Solo
7. Taksin Jepara
8. Aan Solo
9. Dewi Solo
10. Tyas Sukoharjo
11. Retno Solo
12. Tien Diana Solo
13. Najma Thalia Solo
14. Hartati Pemalang
15. Wartiningsih Jogja
16. Rina Klaten
17. Lili Solo
18. Ndaru Karang Anyar
19. Rini Solo
20. Sofi Pekalongan
21. Kholik Brebes
22. Ani Solo
23. Vivin Magelang
24. Siti Gunung Kidul
25. Septi Wonosari

A. Jawablah pertanyaan-pertanyaan berikut.
1. Bagaimana cara mengatur lebar kolom dan tinggi baris?
2. Bagaimana cara menyisipkan baris baru?
3. Bagaimana cara menyisipkan kolom baru?
4. Bagaimana cara memberi bingkai pada lembar kerja?
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Setelah menggunakan Fitur Protection jika kamu ingin mengubah-ubah
lembar kerja maka akan muncul peringatan seperti gambar di bawah dan
proteksi telah aktif.

Gambar 7. 42 Tampilan kotak peringatan dalam Fitur Protection

H. Memberi Proteksi pada Lembar Kerja

• Klik menu Tools pada main menu bar.
• Pilih dan klik menu Protection.
• Pilih Protect Sheet.
• Kemudian isilah password pada kotak seperti pada gambar berikut.
• Isi kembali password yang telah kamu buat sebelumnya pada kotak di

bawah ini.

Agar pekerjaan kamu tidak dapat dibuka oleh orang lain, kamu dapat
menggunakan Fitur Protection pada Microsoft Excel. Fitur tersebut dapat
menjaga keamanan pekerjaan kamu. Selain itu, Protection juga dapat diatur
untuk memproteksi sel-sel tertentu sesuai apa yang kamu inginkan. Adapun
langkah-langkahnya adalah sebagai berikut.

Gambar 7. 40 Tampilan menu Tools

Gambar 7. 41 Tampilan Protect Sheet
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Aktivitasku

Untuk menghilangkan proteksi, kamu tinggal
kembali ke menu semula kemudian pilih dan klik
menu Unprotect, masukan password yang tadi kamu
masukan.

Gambar 7. 46 Tampilan kotak dialog Unprotect

Rangkuman

Coba lakukan langkah-langkah berikut ini.
1. Bukalah lembar kerja Ms. Excel yang masih kosong.
2. Buatlah tabel perhitungan pengeluaran kamu selama seminggu.
3. Format tabel hasil pekerjaanmu.
4. Simpanlah hasil pekerjaanmu ke dalam folder.

• Menyorot atau memblok sel pada lembar kerja Excel dapat dilakukan dengan
menggunakan keyboard dan mouse.

• Menu Insert digunakan untuk menambahkan sel, baris, atau kolom baru.
• Autofill berfungsi untuk memasukkan data dengan cepat.
• Comma berfungsi untuk memberi tanda titik sebagai pemisah ribuan.
• Format Accounting digunakan untuk memberi satuan mata uang pada data

yang telah kamu buat.
• Align berfungsi untuk mengatur paragraf.
• Orientation berfungsi untuk merubah kemiringan teks.
• Wrap text berfungsi untuk menyambung beberapa sel.
• Fill Color berfungsi untuk memberi warna pada sel yang kamu pilih.

Gambar 7. 44 Tampilan Confirm Password
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Refleksi

Untuk menjalankan Microsoft Excel, kamu harus mengetahui teknik dasarnya terlebih
dahulu. Jika sudah tahu teknik dasar Microsoft Excel, kamu dapat membuat data
statistik atau data apa saja yang berhubungan dengan penghitungan angka. Kamu
harus sering melakukan latihan agar cepat menguasai teknik dasar Microsoft Excel.

1. Perhatikan gambar di atas.
Gambar di atas merupakan contoh
memblok...
a. kolom
b. sel
c. baris
d. kolom dan baris

2. Untuk mengatur tampilan data agar
rata kiri, rata kanan atau di tengah
sel yaitu...
a. Format, Cells, Alignment
b. Format, Cells, Border
c. Format, Cells, Font
d. Format, Cells, Number

3. Wrap text yang terdapat dalam kotak
dialog Format Cells pada Tab
Alignment berfungsi untuk...
a. mengatur data pada suatu sel

ditampilkan dengan ukuran
menjadi lebih kecil

b. menggabungkan beberapa sel
menjadi satu sel

c. mengatur data pada suatu sel
dengan pelipatan ke bawah
pada sel yang sama.

d. mengatur data pada suatu sel
dengan pelipatan ke bawah
pada sel yang berbeda.

Uji Kompetensi

Ayo, kerjakan di buku tugasmu
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

4. Untuk menampilkan garis pembatas atau
bingkai dengan cara...
a. Format, Cells, Border
b. Format, Cells, Patterns
c. Format, Cells, Number
d. Format, Cells, Font

5. Memilih dan mengklik Insert, Rows
berfungsi untuk...
a. menyisipkan kolom
b. menyisipkan sel
c. menyisipkan baris
d. menyisipkan garis pembatas

6. Untuk menghapus sel, baris dan kolom
menggunakan...
a. Insert, Delete
b. Format, Delete
c. Edit, Delete
d. Edit, Paste

7. Langkah untuk menyembunyikan lembar
kerja yaitu...
a. Format, Sheet, Hide
b. Hide, Sheet, Format
c. Sheet, Format, Hide
d. Hide, Format, Sheet

8. Untuk melindungi lembar kerja agar tidak
dengan mudah diubah oleh orang lain
yaitu dengan menggunakan...
a. Tools c. Protection
b. Protect Sheet d. Password



Teknologi Informasi dan Komunikasi VIII SMP134

9. Ikon di samping bernama...
a. Merge cell c. Center
b. Warp Text d. Alignment

10. Unprotect Sheet di gunakan untuk...
a. membuka password
b. mengunci sel
c. membatalkan penguncian
d. membuka proteksi

B. Jawablah pertanyaan-pertanyaan di bawah ini dengan benar!
1. Tuliskan 3 langkah menggunakan menu Protection!
2. Jelaskan langkah-langkah menyisipkan sel, baris dan kolom!
3. Apa yang dimaksud dengan Nilai Absolut dan fungsinya?
4. Bagaimana langkah-langkah mengubah kemiringan teks hingga 180 derajat!
5. Jelaskan langkah-langkah menyembunyikan tampilan kolom!
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Fungsi Dasar
Lembar Kerja Excel

Microsoft Excel menyediakan beberapa aplikasi untuk melakukan
penghitungan. Adapun penghitungan-penghitungan tersebut dilakukan
dengan menggunakan rumus-rumus secara praktis. Dengan Microsoft
Excel, tentu kamu akan lebih mudah dan lebih cepat melakukan
penghitungan. Ayo, pelajari bab ini dengan baik agar kamu lebih mahir
menggunakan rumus-rumus yang terdapat pada Microsoft Excel.

Bab 8
Tujuan Pembelajaran
Setelah mempelajari bab ini, kamu diharapkan mampu:
1) memahami rumus dan fungsi lembar kerja Excel;
2) menggunakan nilai absolut;
3) mengetahui fungsi statisik dasar Microsoft Excel.
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Peta Konsep

Kata Kunci

• Formula
• Function
• Sel
• SUM

• MAX
• Average
• Vlook Up
• IF

Memahami Rumus dan
Fungsi Lembar Kerja

Excel

Fungsi Vlook Up

Fungsi Dasar Lembar Kerja Excel

Fungsi Logika IF

Fungsi Hlook Up

Penggunaan Nilai
Absolut

Fungsi Count IF

Fungsi Statisik
Dasar

Fungsi Sum IF
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A. Memahami Rumus dan Fungsi Lembar Kerja Excel

Rumus (formula) adalah salah satu bentuk perhitungan yang dibuat untuk
tujuan tertentu, misalnya menjumlahkan, mengurangkan, dan mengalikan.

Fungsi (function) adalah rumus siap pakai yang digunakan sebagai alat
untuk membantu proses perhitungan. Fungsi-fungsi dibagi menjadi beberapa
kelompok fungsi, yaitu sebagai berikut.
- Fungsi yang paling terakhir digunakan.
- Fungsi keuangan.
- Fungsi tanggal dan waktu.
- Fungsi matematika dan trigonometri.
- Fungsi statistik.
- Fungsi pembacaan tabel dan referensi.
- Fungsi logika.
- Fungsi teks.
- Fungsi baris data.
- Fungsi informasi.

Untuk menghitung data-data berjenis angka yang tedapat pada baris 4-
13 pada gambar di bawah, ikuti langkah-langkah berikut.
• Klik pada kolom yang ingin dihitung.
• Awali rumus dengan tanda “=”.
• Klik sel yang ingin dihitung.
• Tekan tombol Enter.

Gambar 8. 1 Tampilan tabel perhitungan
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Hasil dari rumus matematika akan tampak seperti pada gambar di
bawah. Setelah itu kamu dapat menyalin rumus dari sel E4 karena cara
perhitungan (E5-E13) = E4.

Gambar 8. 3 Tampilan Pengcopyan rumus

Sebagai contoh,
• Klik kolom E4.
• Setiap awal perhitungan harus menggunakan “=”.
• Setelah itu, klik sel yang ingin dihitung, contoh C4-D4.
• Tekan tombol Enter.

Gambar 8. 2 Tampilan contoh perhitungan
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Aktivitasku

1. Ketiklah lembar kerja seperti yang terlihat pada gambar di atas.
2. Data masukan yaitu, No, Nama Komik, Jumlah Buku, Jumlah Buku yang

terjual, Sisa Buku, Harga Jual dan Penjualan.
3. Ketentuan proses:

- Sisa buku diperoleh dari jumlah buku-jumlah buku yang terjual.
- Penjualan diperoleh dari jumlah buku yang terjual*harga jual.

4. Simpanlah lembar kerja kamu dengan nama PT. Komik.

B. Penggunaan Nilai Absolut

Nilai Absolut merupakan nilai yang tidak pernah berubah. Nilai absolut
ini tidak berubah meski telah dipindahkan atau dikopi ke dalam sel lain. Hal
ini sangat berguna untuk mempermudah dan mempercepat proses.

Agar kamu lebih mudah memahami, lihatlah contoh berikut ini. Pada
tabel di bawah, kamu akan membuat tabel perkalian 5, 6, dan 7. Agar lebih
mudah dan cepat menghitungnya kamu dapat menggunakan rumus absolut,
yaitu F4.
• Buatlah tabel.
• Data masukan yaitu perkalian 5, 6, dan 7.
• Pada kolom perkalian masukan data 1-10.
• Sorot pada sel B5.

Perhatikan gambar berikut.
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Gambar 8. 4 Contoh tampilan tabel perkalian

Gambar 8. 5 Tampilan penggunaan rumus absolut

• Klik pada sel  A5 kemudian tekan tombol * (perkalian) dan klik pada sel
B5 kemudian tekan tombol F4.

• Tekan Enter.
• Kemudian salinlah rumus tersebut dengan cara mengcopy.
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Gambar 8. 6 Hasil penulisan rumus absolut

Aktivitasku

A. Ayo, kerjakan yang berikut ini.
1. Ketiklah lembar kerja seperti yang terlihat pada gambar di atas.
2. Data masukan yaitu : Nama Buah, Berat / kg, dan Total Pembelian.
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Untuk menghitung total keseluruhan menggunakan rumus =Sum(range),
lihatlah contoh gambar berikut.

Gambar 8. 7 Tampilan  penggunaan rumus Sum

B. Ayo, kerjakan yang berikut ini.
1. Bukalah lembar kerja Excel kamu.
2. Buatlah tabel mengenai harga barang di toko dekat sekolahmu.
3. Data masukan: Nama Barang, Jumlah Barang, Harga Barang, Total

dan Total Keseluruhan.
4. Simpan hasil lembar kerja kamu dengan nama sesuai keinginan kamu.

3. Ketentuan proses:
-Total Pembelian diperoleh dari Berat/kg*Harga 1 kg
(Menggunakan rumus absolut).

4. Simpanlah hasil lembar kerja kamu dengan nama Toko Buah Segar.

Fungsi statistik dasar
1. Sum berfungsi untuk menjumlahkan isi sebuah Range.

=SUM(range)
2. Average berfungsi untuk mendapatkan rata-rata Range.

=Average(range)
3. Max berfungsi untuk mendapatkan nilai terbesar dari sebuah Range.

=Max(range)
4. Min berfungsi untuk mendapatkan nilai terkecil dari sebuah Range.

=Min(range)
5. Count berfungsi untuk menghitung jumlah data dari sebuah Range.

=Count(range)

C. Penggunaan Fungsi Statistik Dasar
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Gambar 8. 9 Tampilan penggunaan fungsi dasar statistik

Gambar di bawah merupakan hasil perhitungan menggunakan Sum
kemudian di copy ke samping.

Gambar 8. 8 Tampilan hasil perhitungan total keseluruhan

Gambar di bawah merupakan hasil perhitungan menggunakan fungsi-
fungsi dasar statistik.
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D. Penggunaan Fungsi Logika IF

Untuk mengisi nilai huruf pada tabel di bawah dengan ketentuan:
- Nilai angka lebih kecil sama dengan 5 maka nilai hurufnya C.
- Nilai angka lebih kecil dari 8 maka nilai hurufnya B.
- Selain itu, nilai hurufnya A.

Gambar 8. 10 Tampilan penggunaan rumus IF

Rumusnya menjadi:
=IF(B4<=5;”C”;IF(B4<8;”B”;”A”))
Setelah itu, Copy rumus ke bawah hingga ke sel C8.

Gambar 8. 11 Tampilan pengkopian rumus

=IF(Logika Ekspresi; Nilai jika benar; Nilai jika salah)
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Aktivitasku

Berdasarkan tabel di atas, coba kamu lakukan hal-hal berikut.
1. Bukalah lembar kerja Excel yang masih kosong.
2. Buatlah tabel dengan data masukan:

- Nama Murid, Nilai Angka, Nilai Huruf, dan Kategori
3. Ketentuan:

- Nilai Huruf (Jika nilai angka lebih kurang sama dengan 65 maka nilai huruf C)
- Kategori (Jika nilai angka lebih kurang sama dengan 85 maka nilai huruf B)

4. Hitunglah:
- Nilai rata-rata
- Nilai tertinggi
- Nilai terendah
- Jumlah data yang ada

E. Penggunaan CountIF

CountIF (Range;kriteria) digunakan untuk menghitung jumlah kehadiran
Tim basket putra berdasarkan kriteria “x”.

=CountIF (Range;kriteria)
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Gambar 8. 12 Tampilan tabel daftar hadir peserta latihan basket

Rumusnya =CountIF(C7-H7;”x”)

Gambar 8. 14 Tampilan Tabel perhitungan menggunakan CountIF

Aktivitasku

Coba kamu kerjakan hal-hal berikut ini.
1. Buatlah tabel data absen dalam kelasmu.
2. Kemudian hitung jumlah kehadiran, izin dan jumlah alpa teman-temanmu
3. Simpan hasil kerja kamu dengan nama Daftar Absen Kelas.

Gambar 8. 13 Tampilan penggunaan rumus CountIF
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=SumIF(Range; Kriteria; Sum Range) digunakan untuk menghitung
total anak yang bernilai A menggunakan rumus =SumIF(B5:B16;”A”;C5-
C16). Adapun untuk menghitung total anak yang bernilai B dan C, kamu
dapat  menggunakan rumus yang sama, hanya “A” tadi diganti dengan “B”
atau “C”.

Jadi, untuk menghitung total anak dengan nilai “B” dan Total nilai “C”
menggunakan rumus yang sama, tetapi mengganti kriterianya, contoh:
=SumIF(B5:B16;”B”;C5:C16).

F. Penggunaan Fungsi SumIF

Gambar 8. 15 Tampilan penggunaan rumus SumIF

Gambar 8. 16 Tampilan perhitungan data menggunakan rumus SumIF
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Rangkuman

• Formula adalah bentuk penghitungan yang kamu buat sendiri dengan tujuan
tertentu, misalnya untuk menjumlahkan, mengurangkan, dan mengalikan.

• Function adalah rumus yang telah disediakan oleh Microsoft Excel yang
membantu proses penghitungan.

• Sum berfungsi untuk menjumlahkan isi sebuah range.
• Average berfungsi untuk mendapatkan nilai rata-rata range.
• Max berfungsi untuk mendapatkan nilai terbesar dari sebuah range.
• Count berfungsi untuk menghitung jumlah data dari sebuah range.

Refleksi

Untuk melakukan penghitungan dalam Micrososft Excel, kamu dapat menggunakan
rumus-rumus yang telah tersedia. Nah, agar kamu cepat menghafal rumus-rumusnya,
kamu harus sering berlatih.

1. Fungsi Sum untuk...
a. Menjumlahkan isi sebuah sel
b. Mendapatkan nilai Tertinggi
c. Menhitung rata-rata range
d. Menghitung jumlah data

2. Fungsi Average untuk...
a. Menjumlahkan isi sebuah sel
b. Mendapatkan nilai Tertinggi
c. Menghitung rata-rata range
d. Menghitung jumlah data

3. Fungsi Count untuk...
a. Menjumlahkan isi sebuah sel
b. Mendapatkan nilai tertinggi
c. Menghitung rata-rata range
d. Menghitung jumlah data

4. Fungsi Max untuk...
a. Menjumlahkan isi sebuah sel
b. Mendapatkan nilai Tertinggi
c. Menhitung rata-rata range
d. Menghitung jumlah data

Ayo, kerjakan di buku tugasmu.
A. Berilah tanda silang (x) pada jawaban yang kamu anggap benar.

Uji Kompetensi

5. Fungsi Min untuk...
a. Menjumlahkan isi sebuah sel
b. Mendapatkan nilai terendah
c. Menghitung rata-rata range
d. Menghitung jumlah data
Untuk menjawab soal 6 - 9 perhatikan
gambar ini!

6. Untuk menghitung total pembelian buah
apel seberat 10 kg dengan cara...
a. =B7*$B$4 c. =B7*C7
b. =B7*B4 d. =B7*B7
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7. Total pembelian pada tabel di atas di
hitung menggunakan...
a. Fungsi Sum c. Nilai Absolut
b. Fungsi IF d. Fungsi HlookUp

8. Untuk menghitung total keseluruhan dari
Total Pembelian dengan...
a. Fungsi IF c. Fungsi Max
b. Fungsi Sum d. Fungsi Count

9. Rumus menghitung total keseluruhan
yaitu...

a. =Sum(C7:C11)
b. =Sum(C7:C14)
c. =Max(C7:C14)
d. =C7+C11

10. Nilai Absolut adalah nilai...
a. Nilai yang selalu berubah
b. Nilai yang tidak pernah berubah
c. Nilai mutlak
d. Nilai tak hingga

B. Jawablah pertanyaan-pertanyaan di bawah ini dengan benar!
1. Apa yang dimaksud dengan Rumus dan Fungsi?
2. Jelaskan kelompok-kelompok fungsi!
3. Apa perbedaan fungsi CountIF dengan SumIF?
4. Jelaskan beberapa fungsi statistik dasar pada Microsoft Excel!
5. Jelaskan penggunaan Fungsi SumIF!
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Glosarium

Add Text : Menyisipkan teks
Align : Posisi Paragraf
Arrange : Mengatur posisi cell atau row.
Auto Format : Fasilitas format auto.
Average : Nilai rata-rata.
AutoShapes : Tab untuk format garis.
Behind Text : Objek diletakkan di belakang teks.
Border and shading : Menu yang berfungsi untuk membuat garis dan background.
Bullet and Numbering : Menu yang digunakan untuk membuat bullet dan penomoran.
Clip Art : Tab untuk menambahkan klip art pada dokumen.
Comma : Pemisah angka dalam ribuan.
Copy : Perintah untuk mengcopy huruf, kata, kalimat, paragraf, garis,

gambar, dll.
Count : Menghitung jumlah data dari sebuah range.
CountIF : Menghitung total data dari sebuah range.
Diagram : Tab untuk membuat struktur organisasi.
Drag and Drop : Memindahkan kata atau kalimat dengan menggunakan mouse.
Drive : Singkatan dari Hard drive/hard disk.
Drop Cap : Mempercantik huruf pertama dari sebuah kalimat/paragraf.
Endnote : Untuk menyisipkan catatan akhir.
Folder : Tempat menyimpan dokumen.
Formula : Rumus buatan (untuk penambahan, pengurangan atau perkalian).
Footnote : Catatan kaki
Function (Fungsi) : Rumus siap pakai yang digunakan untuk membantu proses

penghitungan.
Icon : Gambar atau lamabang dari suatu perintah.
Inden : Pergeseran teks paragraf dengan cara memblok seluruh baris di

paragraf.
In Front of Text : Objek diletakkan di depan teks.
In Line with Text : Objek terletak segaris dengan teks.
Merge Cell : Menu yang berfungsi untuk menyatukan beberapa sel menjadi satu

sel.
Margins : Garis tepi pada window.
MAX : Mendapatkan nilai terbesar dari sebuah range.
Menu Pop up : Menu yang muncul apabila mengklik kanan di tempat tertentu di

dokumen.
Min : Mendapatkan nilai terkecil dari sebuah range.
Page Setup : Pengesetan ukuran kertas.
Paste : Perintah untuk menyalin huruf, kata, kalimat, paragraf, garis, gambar,

dll.
Password : Kata kunci untuk membuka dokumen.
Preview : Tampak dokumen saat akan dicetak.
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Shortcut : Menentukan perintah dengan menggunakan keyboard.
Save : Menyimpan projek yang sedang dikerjakan.
Save As : Menyimpan projek dengan nama lainnya.
Scroll Bar : Berfungsi untuk menggeser halaman yang ditampilkan.
Search : Tab pencarian pada menu help.
Sheet : Lembar kerja Ms. Excel.
SUM : Menjumlahkan isi sebuah range.
SumIF : Menghitung jumlah total dari sel tertentu dari sebuah range.
Tabel : Digunakan untuk mengola data-data.
Task Pane : Jendela kecil yang terdapat pada aplikasi office yang memuat daftar-

daftar perintah yang biasa digunakan.
Title Bar : Baris judul yang telatak di atas jendela Ms. Word
Toolbar : Tombol-tombol yang mewakili perintah-perintah yang terdapat pada

menu.
Windows : Sistem Operasi
Word Processor : Sofware aplikasi pengolah kata.
Word Art : Tab untuk memberi variasi bentuk teks.
Workbook : Buku kerja (nama lain microsoft excel)
Worksheet : Lembar kerja microsoft excel
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Indeks

A About Microsoft Excel; 90
Accounting; 117
Activate Product; 90
Align; 118
Arrange; 89
AutoFill; 114
AutoFormat; 58, 69
Average; 134
AutoShapes; 53, 55-56

B Border and Shading; 35-37, 101
Bullet and Numbering; 32-33

C Cell (sel); 72-74, 91, 99-101, 108,
113, 117-120, 130-131
Clip Art; 33, 48
Columns (kolom); 39, 66, 72, 110-
111, 132
Comma; 116
Compare Side By Side; 89
Count; 134
CountIF; 136

D Detect and Repair; 90
Diagram; 57, 59
Drop Cap; 38

E Endnote; 42-43

F Folder; 19
Formula; 90, 130-131
Footnote; 42-43
Function (Fungsi); 130

H Header and Footer; 25
Help; 9, 90
HlookUp; 137-138
Horizontal Line; 36-37

I Icon (ikon); 3-10, 19, 36, 70-72,
84, 86-90, 94-97
IF; 135
Insert; 48, 67, 74, 113
In Line with Text; 50-51

M Margins; 26-27
MAX; 134
Maxmize;  4
Merge; 118
Microsoft Excel; 67, 74, 80-81, 90,
100, 114

N New Document; 20
New Window; 89
Numberings; 33, 34

O Office Assistant; 90
Organization Chart; 58
Orientation; 121-122

P Page Setup; 25-27
Password; 124
Protection; 124

R Restore; 4
Rows; 66, 72-74, 91-92, 99, 111

S Shortcut; 3, 18, 49, 82, 84
Save; 19
Save As; 19
Search; 9, 48
Sizing Button; 98
Style; 35
SUM; 134
SumIF; 137

T Table; 59, 66-67, 69-70, 132
Task Pane; 20
Toolbar Drawing; 4, 7, 57, 92
Toolbar Formatting; 4,6, 21, 92
Toolbar Picture; 552
Toolbar Standar; 4-5, 92, 94

V VlookUp; 137-138

W Wrap; 121
Word Art; 23
Word Processor; 2
Workbook; 83
Worksheet; 74, 91
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Lampiran

Praktikum 1   Menyisipkan Teks baru dan Mencari Kata secara Otomatis

Langkah 1
Petunjuk
1. Kutiplah naskah di bawah ini dengan benar.
2. Setelah selesai simpan di folder kerja anda dengan nama MODUL-1.
3. Tutuplah dokumen kamu.
4. Aktifkan kembali dokumen MODUL-1.
5. Jika masih ada waktu lanjut ke tugas 2.

LONCENG KEHADIRAN KUCING

Yang pertama berbicara adalah seekor tikus muda yang merasa dirinya gampang bijaksana.
Dia berdiri dan berkata, “Teman-temanku, aku dapat memecahkan masalah ini. Dengar,
yang harus kita lakukan adalah membeli sebuah lonceng. Gantungkan lonceng itu pada
leher kucing. Setiap kali mendengar kucing mendekat kita dapat lari”. Anjuran itu tampak
bagus, maka tikus-tikus lain menyetujuinya dengan gembira.

Ada sekelompok tikus tinggal di sebuah rumah yang luas. Mereka hidup senang. Hanya
karena kehadiran kucing, membuat hidup mereka tidak aman. Setiap hari kucing menerkam
satu atau dua dari mereka. Karena jumlah mereka semakin berkurang maka tikus-tikus itu
sepakat bertemu membicarakan masalah itu.

Sampai akhirnya seekor tikus tua bertanya, “Tetapi siapa yang bersedia mengikatkan lonceng
itu di leher kucing?”. Tentu itu pertanyaan yang sulit dijawab, karena siapa rela melakukannya.

Ada beberapa usaha yang diajukan seperti menggantung kucing atau menggorengnya dalam
minyak yang panas. Namun, karena tidak ada satu pun usulan yang mungkin dilaksanakan,
maka tikus-tikus berpikir lain.
Sumber : 50 Cerita Bijak, 1996

Langkah 2
Petunjuk :
1. Aktifkan kembali dokumen MODUL-1 yang sudah kamu kerjakan sebelumnya.
2. Lakukan penyuntingan teks pada dokumen tersebut.
3. Sisipkanlah teks di bawah ini antara paragraph 3 dan 4.
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Tikus memang makanan empuk untuk kucing lagipula tikus harus dibasmi karena
selain dapat merusak juga membawa penyakit yang berbahaya. Benar khan?
Bagaimana pendapat anda?

4. Sisipkan simbol lonceng di depan judul dokumen tersebut.
5. Pada akhir dokumen ketik “Jakarta :”, kemudian sisipkan tanggal sekarang
6. Di bawah kata Jakarta  ketik “Waktu sekarang menunjukkan pukul :”, kemudian sisipkan

waktu sekarang
7. Hapuslah kalimat “Bagaimana pendapat kamu”, kemudian batalkan kembali
8. Pindahkan paragraf 2 di atas paragraph 1, kemudian paragraph 4 di bawah paragraf

yang baru kamu pindahkan (seperti susunan naskah dibawah ini)
9. Copylah paragraph 2 ke akhir dokumen
10. Ulangi kembali poit 7 s/d 9 pada teks yang lain sampai kamu mahir.
11. Simpanlah kembali dokumen tsb dengan nama MODUL-2 dengan menggunakan Save

As.

LONCENG KEHADIRAN KUCING

Ada sekelompok tikus tinggal di sebuah rumah yang luas. Mereka hidup senang. Hanya
karena kehadiran kucing, membuat hidup mereka tidak aman. Setiap hari kucing menerkam
satu atau dua dari mereka. Karena jumlah mereka semakin berkurang maka tikus-tikus itu
sepakat bertemu membicarakan masalah itu.

Ada beberapa usaha yang diajukan seperti menggantung kucing atau menggorengnya dalam
minyak yang panas. Namun, karena tidak ada satupun usulan yang mungkin dilaksanakan,
maka tikus-tikus berpikir lain.

Yang pertama berbicara adalah seekor tikus muda yang merasa dirinya gampang bijaksana.
Dia berdiri dan berkata, “Teman-temanku, aku dapat memecahkan masalah ini. Dengar,
yang harus kita lakukan adalah membeli sebuah lonceng. Gantungkan lonceng itu pada
leher kucing. Setiap kali mendengar kucing mendekat kita dapat lari”. Anjuran itu tampak
bagus, maka tikus-tikus lain menyetujuinya dengan gembira.
Sampai akhirnya seekor tikus tua bertanya, “Tetapi siapa yang bersedia mengikatkan lonceng
itu di leher kucing?”. Tentu itu pertanyaan yang sulit dijawab, karena siapa rela melakukannya.

Tikus memang makanan empuk untuk kucing lagipula tikus harus dibasmi karena selain
dapat merusak juga membawa penyakit yang berbahaya. Benar, kan ? Bagaimana pendapat
anda !

Sumber : 50 Cerita Bijak, 1996
Jakarta : Sabtu, 11 Oktober 2008
Waktu sekarang menunjukkan pukul : 8:23:04 AM

Lampiran



Teknologi Informasi dan Komunikasi VIII SMP156

Langkah 3
Petunjuk :
1. Aktifkan kembali dokumen MODUL-2
2. Gunakan perintah FIND untuk mencari semua kata tikus pada dokumen tersebut
3. Gunakan REPLACE untuk mencari kata tikus dan menggantinya dengan anjing,

kemudian ubah kembali.
4. Ulangi kembali point 2 dan 3 di atas untuk kata lain.
5. Simpan kembali dokumen tsb dengan nama MODUL-3.

Praktikum 2 Membuat Surat

Dalam praktikum ini kamu diminta membuat surat sesuai teks di bawah. Kemudian kamu
diminta mengatur teks agar tampak lebih rapi.

Langkah-langkah Praktikum
1. Bukalah sebuah dokumen baru di Microsoft Word.
2. Ketiklah sebuah surat permohonan izin tidak masuk sekolah seperti di bawah ini.

Jakarta, 21 Juli 2009
Kepada Yth:
Bapak Agus Nadi
Wali Kelas 1B
SMP Tunas Bakti
di
Tempat
Dengan hormat,
Melalui surat ini, saya anak didik Bapak yang tertanda di bawah ini:
Nama : Ivan Gunawan
Kelas : 1B SMP
Alamat : Jl. Sudirman 45 B Jakarta
Menyampaikan kepada Bapak bahwa saya tidak dapat hadir ke sekolah seperti biasanya
karena saya harus menjaga Ibu saya yang sedang dirawat di Rumah Sakit.
Demikianlah saya sampaikan kepada Bapak. Atas perhatian Bapak saya ucapkan terima
kasih.
Hormat Saya Mengetahui :
Orang Tua
Ivan Gunawan

Mengatur Posisi Teks di Dokumen
Dokumen yang kamu ketik belum rapi, masih membutuhkan pengaturan. Kamu akan
menggunakan tombol Tab dan Enter untuk mengatur posisi teks.

1. Letakkan kursor di akhir kata Tempat. Kemudian tekan tombol Enter dua kali.
2. Letakkan kursor di awal kata Nama, kemudian gunakan tombol tab untuk mengatur

posisi teks. Lakukan untuk baris kelas dan alamat.
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Jakarta, 21 Juli 2009
Kepada Yth:
Bapak Dedi Fajar Riadi
Wali Kelas 1
SMP Tunas Bakti
di
Tempat

Dengan hormat,
Melalui surat ini, saya anak didik Bapak yang tertanda di bawah ini:

Nama :      Ivan Gunawan
Kelas :      1B SMP
Alamat :       Jl. Jend. Sudirman 45 B Jakarta

Menyampaikan kepada Bapak bahwa saya tidak dapat hadir ke sekolah seperti biasanya karena
saya harus menjaga Ibu saya yang sedang dirawat di Rumah Sakit.
Demikianlah saya sampaikan kepada Bapak. Atas perhatian Bapak saya ucapkan terima kasih.

Hormat Saya Mengetahui :
Orang Tua

Ivan Gunawan Agus Nadi

3. Letakkan kursor di awal kata Hormat, kemudian tekan tombol Enter dua kali.
4. Letakkan kursor di awal kata Mengetahui, kemudian tekan tombol Tab sampai posisi

teks tersebut sesuai yang kamu inginkan.
5. Lakukan hal yang sama untuk kata Orang Tua.
6. Letakkan kursor depan kata Remon Gunawan, tekan tombol Tab sampai kata tersebut

sejajar dengan kata Mengetahui.
7. Simpanlah dokumen surat yang sudah kamu buat dengan nama file Praktik Membuat

Surat.

Gambar  Tampilan akhir dokumen

Lampiran
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Dalam praktikum ini kamu diminta membuat kartu, dapat berupa kartu ucapan selamat,
kartu undangan dan sebagainya. Yang terpenting kartu kamu harus berbentuk indah.

Langkah-langkah Praktikum
1. Jalankan Word dan buat dokumen baru.
2. Buatlah sebuah kartu yang berbentuk indah.
3. Gunakan gambar, Word Art, Perwarnaan teks dan sebagainya.
4. Untuk memudahkan menempatkan dan mengatur letak gambar di dokumen, kamu dapat

menempatkan gambar dalam sebuah kotak teks. Dan jika tidak ingin garis kotak teks
kelihatan, maka kamu dapat mengatur warna garis (Line color) dan warna isinya (Fill
color) menjadi No Line dan No Fill.

5. Cetak kartu yang kamu buat.
6. Simpan pekerjaan kamu dengan nama file: Praktik Membuat Kartu

Sebagai contoh, kartu di bawah dapat dicetak kemudian ditempel menjadi bolak-balik.

Praktikum 3 Membuat Kartu

Gambar  Contoh Kartu
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Dalam praktikum ini kamu diminta untuk menghitung luas, sisi miring, dan keliling
segitiga dengan menggunakan rumus yang kamu buat sendiri di Excel. Kemudian menyimpan
lembaran kerja tersebut dengan nama file yang diminta.

Langkah-langkah Praktikum
1. Jalankan Excel dan buat buku kerja baru.
2. Masukkan data sesuai dengan yang ditampilkan tabel di bawah.
3. Hitung luas segitiga dengan mengunakan rumus; Luas = 0,5 x Sisi Datar x  Sisi Tegak.

Maka untuk tabel di bawah kamu harus mengetik di C3 sbb: =0,5*A3*B3.
4. Copykan rumus yang sudah kamu ketik sampai sel C32 [9.1.5;].
5. Hitung sisi miring dengan rumus: =SQRT((A3*A3)+(B3*B3)).
6. Copykan rumus yang kamu ketik sampai sel D32 [9.1.5;].
7. Hitung Keliling segitiga dengan rumus : =A3+B3+D3.
8. Copykan rumus yang kamu ketik sampai sel E32 [9.1.5;].
9. Tambahkanlah batas tabel dan warna sel agar tampilan tabel lebih indah.

Lampiran

Praktikum 4 Membuat Rumus Sederhana
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10. Simpan data yang sudah dimasukkan dengan nama file Membuat Rumus Sederhana.

Praktikum 5 Membuat Range dan Mengganti Nama Sheet

Dalam praktikum ini kamu diminta membuat range dan mengganti nama Sheet.

Langkah 1
1. Buka File Baru
2. Aktifkan sheet1
3. Buatlah range A2:E12, dengan lebar masing-masing kolom adalah 15 dan tinggi baris

adalah 10.
4. Ganti nama Sheet1 dengan nama latih1.

Langkah 2
1. Aktifkan sheet2
2. Buatlah range B5:F12, dengan lebar kolom B = 5, C = 25, D = 10, E = 25, F = 13.
3. Hilangkan garis-garis grid.
4. Ganti nama Sheet2 dengan nama latih2.

Langkah 3
1. Aktifkan Sheet3.
2. Ulangi langkah 2 dan 3 pada tugas 2.
3. Isi data dan buat tabel, seperti contoh berikut.
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SELEKSI PENERIMAAN PEGAWAI
JURUSAN TEKNIK INFORMATIKA

4. Ganti nama Sheet3 dengan latih3.
5. Simpan file tersebut dengan nama Membuat Range dan Mengganti Nama Sheet.

Langkah:
1. Buka File baru.
2. Aktifkan Sheet1.
3. Kerjakan soal berikut.
4. Lembar kerja diberi nama latih 456.

DAFTAR PENJUALAN HAND PHONE
PT. De Java Celuler
Jl. Kartini No. 34 Jakarta

Keterangan:
Bila unit pembelian >12 unit, pembeli akan mendapat hadiah berupa “Kartu Telepon”

Praktikum 6 Menggunakan Fungsi
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Kolom Hadiah diisi dengan tulisan “Kartu Telepon” apabila Unit Pembeliannya lebih
besar dari atau sama dengan 12, tetapi bila Unit Pembelian tersebut dibawah 12, tulis
“Tidak Dapat”.
Berdasarkan ketentuan di atas, kamu dapat menggunakan fungsi IF di sel C6 dengan rumus:

=IF (B6>=12,”Kartu Telepon”,”Tidak Dapat”)
Selanjutnya kamu salin rumus tersebut ke bawah sampai dengan data terakhir.

Praktikum 7 Membuat Grafik

Dalam praktikum ini kamu diminta untuk memasukkan data yang diberikan ke lembaran
kerja Excel, membuat grafik, dan menyimpan lembaran kerja tersebut dengan nama file
yang diminta.

Langkah-langkah:
1. Buatlah sebuah buku kerja baru di Excel.
2. Ketik data praktikum di bawah ini.

No.           A      B        C            D

Pengukuran ke-        Temperatur            Zat 1                  Zat 2

1 20 250,0000 250, 0000

2 30 250,0090 250,0340

3 40 250,0180 250,0680

4 50 250,0270 250,1020

5 60 250,0360 250,1360

1

2

3

4

5

2. Buatlah grafik perubahan muai volume zat 1 dan zat 2 terhadap perubahan temperatur.
3. Aturlah tampilan grafik agar mudah dibaca.
4. Simpanlah buku kerja dengan nama file Praktik Membuat Grafik.
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